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Using This Guide

Congratulations on your purchase of Avid® Interplay®, a powerful system for managing
media in a shared storage environment. This guide contains overview installation
instructions and configuration information for the Interplay components on the Avid
Interplay Installer DVD.

This guide is intended for all Avid Interplay administrators who are responsible for
installing, configuring and maintaining an Avid Interplay Engine or Avid Interplay Archive
Engine (database, server, and all related client connections and user rights) in an Interplay
workgroup.

The documentation describes the features and hardware of all models. Therefore, your
system might not contain certain features and hardware that are covered in the

documentation.
Date Revised Changes Made
4/17/08 Added info on Windows Server 2003 SP2 for server configs. See “Interplay Server

System Configurations” on page 139.

03/26/08 Clarified Multicast Repeater info. You don’t need to use a Multicast Repeater if you are
using Unicast Discovery across subnets. Added info on installing Transfer client for
Interplay v1.2.3. See “Assist and Instinct Installers Require Manual Install of Transfer
Client” on page 74.

02/01/08 Updated info on configuring a Lookup Service. See “Installing the Lookup Service on a
Separate Server” on page 113. Also added info about installing Pro Tools Client software
from the Interplay Installer DVD. See “Installing Software on a Pro Tools Interplay
Client” on page 91.

12//17/07 Added section on updating Intel drivers. See “Updating Intel Drivers on Cluster
Systems” on page 18. Updated info on workspace names. See “Workspace Names” on
page 22. Updated the Interplay shutdown procedure. See “Complete Server Room
Shutdown” on page 153.




Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

AN
Jia

(Windows), (Windows
only), (Macintosh), or
(Macintosh only)

Bold font

Italic font

Courier Bold font

Ctrl+key or mouse action

A note provides important related information, reminders,
recommendations, and strong suggestions.

A caution means that a specific action you take could cause harm to
your computer or cause you to lose data.

A warning describes an action that could cause you physical harm.
Follow the guidelines in this document or on the unit itself when
handling electrical equipment.

This symbol indicates menu commands (and subcommands) in the
order you select them. For example, File > Import means to open the
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list
indicate that you perform one of the actions listed.

This text indicates that the information applies only to the specified
operating system, either Windows or Macintosh OS X.

Bold font is primarily used in task instructions to identify user interface
items and keyboard sequences.

Italic font is used to emphasize certain words and to indicate variables.
Courier Bold font identifies text that you type.

Press and hold the first key while you press the last key or perform the
mouse action. For example, Command+Option+C or Ctrl+drag.

If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It
is especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation

was published:



Viewing Documentation on the Interplay Portal

- If'the latest information for your Avid product is provided as printed release notes,
they ship with your application and are also available online.

If the latest information for your Avid product is provided as a ReadMe file, it is
supplied on your Avid installation CD or DVD as a PDF document
(README_product.pdf) and is also available online.

You should always check online for the most up-to-date release notes or ReadMe
because the online version is updated whenever new information becomes
available. To view these online versions, select ReadMe from the Help menu, or visit
the Knowledge Base at www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/onlinesupport. Online services are
available 24 hours per day, 7 days per week. Search this online Knowledge Base to find
answers, to view error messages, to access troubleshooting tips, to download updates,
and to read or join online message-board discussions.

Viewing Documentation on the Interplay Portal

You can quickly access PDF versions of the Interplay user guides from any system in the
Interplay environment.
To open the Interplay Portal web page:
1. Type the following line in your web browser:
http://Interplay Engine name

For Interplay_Engine_name substitute the name of the computer running the Interplay
Engine software. For example, the following line opens the portal web page on a system
named docwg:

http://docwg

2. Click the “Avid Interplay Documentation” link to access the User Information
Center page.
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Interplay Documentation
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The following documents describe how to use Avid Interplay:

Avid Interplay Best Practices — provides an overview of the major Interplay
components, shows sample configuration diagrams, and describes several of the key
features, such as setting up a user database and using the Avid Interplay Archive Engine.

Avid Interplay Software Installation and Configuration Guide — describes how to use
the Avid Interplay Installer DVD to install and configure software on the various
systems that make up a Interplay environment.

Avid Interplay Engine Failover Guide — describes how to set up a cluster configuration
for the Avid Interplay Engine and the Avid Interplay Archive engine.

Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide —
describes how to administer your Avid Interplay Engine or Avid Interplay Archive
Engine and Avid Interplay database.

Avid Interplay Access User’s Guide — describes how to use Interplay Access to browse,
search, and work with assets in the Avid Interplay database.

Avid Interplay Assist User’s Guide — describes how to use Interplay Assist for logging,
archiving, and sending to Playback material in an Interplay environment.

Avid Interplay Framework User’s Guide — describes how to use the logging,
monitoring, and management features of the Avid Interplay Framework applications.

Avid CaptureManager User’s Guide — describes how to use CaptureManager™ in a
newsroom environment to coordinate video feeds, schedule feed captures at both high
and low resolutions, and record late breaking events instantly.

Avid CaptureManager Installation and Configuration Guide — describes how to set up
and configure CaptureManager.

Avid Low Res Encode Setup and Configuration — describes how to set up and configure
an Avid Low Res Encode system. Includes information on updating the bootset, root
disk image, and configuring a Low Res Encode system to work with CaptureManager.

Avid Interplay Transfer Setup and User’s Guide — describes how to use Interplay
Transfer to transfer media to and from another workgroup, send finished sequences to a
configured playback device, ingest media from a configured ingest device, and perform
standalone transfers between workstations.

Avid Interplay Media Services Setup and User’s Guide — Avid Interplay Media
Services lets you control and automate Transcode, Archive, and ProEncode services.

Avid iNEWS Instinct User’s Guide — describes how to use the Avid iNEWS Instinct
application to write INEWS stories and put together simple audio and video sequences.



Accessing the Online Library

All documents are available in PDF form on the Avid Interplay Online Library DVD and
also on the Avid Knowledge Base at www.avid.com/onlinesupport.

Accessing the Online Library

The Avid Interplay Online Library DVD contains all the Avid Interplay product
documentation in PDF format.

You will need Adobe® Reader® to view the PDF documentation online. You can download
the latest version from the Adobe web site.
To access the online library from the Online Library DVD:
1. Insert the Online Library DVD into the drive.
2. Double-click the Mainmenu file.
The Interplay Online Library contains several multimedia feature presentations. This

multimedia content is an excellent first resource for learning how to use an application or for
understanding a particular feature or workflow.

How to Order Documentation

Av

To order additional copies of this documentation from within the United States, call Avid
Sales at 800-949-AVID (800-949-2843). If you are placing an order from outside the United
States, contact your local Avid representative.

d Training Services

Avid makes lifelong learning, career advancement, and personal development easy and
convenient. Avid understands that the knowledge you need to differentiate yourself is always
changing, and Avid continually updates course content and offers new training delivery
methods that accommodate your pressured and competitive work environment.

To learn about Avid's new online learning environment, Avid Learning Excellerator™
(ALEX), visit http://learn.avid.com.

For information on courses/schedules, training centers, certifications, courseware, and
books, please visit www.avid.com/training or call Avid Sales at 800-949-AVID
(800-949-2843).
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This document describes how to use the Avid Interplay Installer DVD to install the various
Interplay components. This includes the order in which to install items and any special
considerations when you are combining services and applications on the same system.

See the installation check list for a list of the various steps required to install the Interplay
products.

This chapter describes the following topics:

*  Upgrading Your System

*  Updating Intel Drivers on Cluster Systems

» Installation Check List and Installation Steps

* Set Up and Configure Your Avid Unity System

*  Network Considerations

»  User Names and Passwords Required For Avid Unity and Product Servers
*  Required Application Keys

*  Software Installed on Avid Interplay Systems

»  Using the Interplay Installer
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Upgrading Your System

Before you begin, see the Avid Interplay ReadMe for specific instructions on upgrading
for a particular release.

The following items apply to upgrading the components on your Interplay system:

*  Back up your Interplay database and any other user data before you upgrade. For
information on backing up your database, see the Avid Interplay Engine and Avid
Archive Engine Administration Guide.

e Use the Interplay Installer DVD software to uninstall the previous versions of software
components. You do not have to use the Control Panel to uninstall.

* Do not uninstall the Avid Interplay Engine or Interplay Archive Engine software unless
instructed by Avid support. Uninstalling the software could require additional steps to
reactivate your database. When upgrading, the installation software takes care of
removing the previous version of the software.

Updating Intel Drivers on Cluster Systems

Do not install or update Intel NIC drivers on cluster systems after the cluster setup is
complete. Due to the technical aspects of changing resources and devices on a cluster, this
can lead to problems with the cluster software and possible data loss.

Older versions of the ISIS v1.4 Readme recommend that you update the Intel Pro MT/PT
drivers on ISIS clients. This statement does not apply to Interplay Engine cluster systems.
The Intel drivers on cluster systems do not require updating for this release. Doing so could
compromise the integrity of the cluster. In general, do not update the hardware drivers on a
cluster system unless instructed to do so by the Interplay Readme or Customer Support.

Installation Check List and Installation Steps
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You use the Interplay Installer DVD to install Interplay software components on the various
servers and clients. This document describes how to use the Interplay Installer DVD and also
points to appropriate documents for additional configuration information.

Use the individual installer DVDs for the various Avid editing applications and use the
Interplay Installer DVD to install the software required to make the Avid editing application
a client of the Interplay environment.

The application software for Avid Interplay Assist and Avid iNEWS® Instinct® is on the Avid
Interplay Installer DVD.



Installation Check List and Installation Steps

To install and configure the software:

1.

Determine how you will set up your Interplay environment. There are sample
configurations in the Avid Best Practices guide and you should discuss the setup with
your Avid representative. In particular, do the following:

- Determine your Media Indexer server configuration. See the Avid Interplay Best
Practices guide and “Software Installed on Media Indexer Servers” on page 35.

- Determine where the Avid Lookup Service will run. The Lookup service is part of
the Interplay Framework. See “Interplay Framework Components” on page 31.
Also see “Software Installed on Avid Interplay Systems” on page 30, “Installing the
Lookup Service on a Separate Server” on page 113, and “Connecting Systems
Directly to the Lookup Service” on page 116.

- Ifyou use AirSpeed® systems to capture media, determine where you will install
the Interplay Adapter. See “Interplay Adapter and AirSpeed” on page 127.

- Ifyou are using Interplay Transcode or an Interplay Archive Engine, determine
where your Interplay Media Services server will reside and where your Transcode,
ProEncode™, and Archive providers will reside. One Transcode and one
ProEncode provider can reside on the same system as the Interplay Media Services
but an Archive Provider might require its own server.

. Check your Network as described in “Network Considerations” on page 23.

. Set up the physical hardware that will be used in your Interplay environment. See the

following for additional information:

- “SR2400 and SR2500 Slot Locations” on page 133
“Interplay Server System Configurations” on page 139

- “Avid Interplay Port Usage” on page 155

. If you will be setting up a cluster (failover) configuration of the Avid Interplay Engine

or Avid Interplay Archive Engine, see the Avid Interplay Engine Failover Guide on the
Avid Knowledge Base.

. Set up and configure your Avid Unity™ MediaNetwork or Avid Unity ISIS™ gystem.

See “Set Up and Configure Your Avid Unity System” on page 22 and “User Names and
Passwords Required For Avid Unity and Product Servers” on page 25.

. Create a Server Execution User account on the Avid Unity system and, if applicable, on

the domain. See “Creating the Server Execution User Account” on page 26.
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7. On the Interplay Engine server, use the Interplay Installer DVD to install the
following:

a. Interplay Engine software.

When you install the Interplay Engine for the first time, you must use the Custom
Install option so that you can specify the Server Execution User required by the
Interplay Engine. See “Creating the Server Execution User Account” on page 26.

The user who installs the Interplay Engine must have an Administrator login and a
password on the Interplay Engine system. That same user name and password must exist on
the Avid Unity system. For more information about user accounts, see “User Names and
Passwords Required For Avid Unity and Product Servers” on page 25.

b. Interplay Access software

Follow this installation order, installing Interplay Access last. See “Installing Software
on the Interplay Engine Server” on page 43.

Make sure that you obtain and load the Interplay Engine license key promptly. The license
key must match the dongle for the Interplay Engine server. For more information, see the
Avid Interplay Engine and Avid Archive Engine Administration Guide.

8. Configure the Interplay Engine software to create the Interplay Engine database and
create users. See the Avid Interplay Engine and Avid Archive Engine Administration
Guide. For information on setting up a user database, see Avid Interplay Best Practices.

9. Perform the following procedures on the systems that will run the Avid Interplay
Media Indexers that monitor shared storage:

a. Use the Interplay Installer DVD to install the appropriate Interplay Framework
software. Do not install all components on a Media Indexer server. For more
information, see “Software Installed on Media Indexer Servers” on page 35.

When you install the Interplay Framework software, you must name your workgroup. The
name is case sensitive and should not contain spaces. You can either choose a useful name
or use the default, AvidWorkgroup. The only time you are required to supply a unique name
is when you have more than one Interplay workgroup on the same network. For example,
this could happen at a large customer site.

On Avid Unity ISIS you must set the “Use UNC (Letterless) Drive Mapping” option on the
Media Indexers that monitor shared storage. In the Client Manager window, select
Preferences, and select the letterless option.

b. Verify that the Interplay Framework is running. See “Verifying that the Interplay
Framework Services Are Running” on page 99.
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Install the Media Indexer software. See “Installing Software on an Avid Interplay
Media Indexer Server” on page 61.

Before you configure the Media Indexer software, make sure there is an

Avid MediaFiles directory on each workspace that the Media Indexer will monitor.
You can use an Avid editing system to capture or import media to the workspace.
You can also create the directory manually but, if you do, carefully check the
spelling and case of the text in the folder name.

Configure the Media Indexer in the High Availability Group to monitor your shared
storage. See “Configuring a Media Indexer to Monitor Shared Storage” on page 63.
You must use UNC paths to identify the shared storage folders. If you are
configuring Media Indexer delegates, see Interplay Best Practices.

For redundancy you can configure Media Indexer standby delegates. See Interplay
Best Practices.

If you have a workspace that contains a lot of files that are not Avid media files, do not
connect the Media Indexer to the top level workspace. Connect to the Avid MediaFiles folder
or another sub folder.

10. Set the Automatic Restart feature in the Avid Interplay Framework to ensure that Media
Indexer will automatically restart. See “Setting the Automatic Restart Feature in the
Avid Interplay Framework™ on page 111.

11. At this point you can install and configure the following applications in any order:

Install the Interplay software components for the Avid editing applications. See
“Installing Software on Avid Editing Systems” on page 76. See “Connecting the
Media Indexer on an Avid Editing System to the Media Indexer Monitoring Shared
Storage” on page 80.

Install the Interplay software components and application software for Avid
INEWS Instinct and Avid Interplay Assist. See “Installing Software on Avid
Instinct and Avid Interplay Assist Systems” on page 72.

Install the Interplay software components on any systems that will run the
Interplay Access software. See “Installing Software on an Interplay Access
System” on page 74.

Install and configure Interplay Transfer. See “Installing Software on the Interplay
Transfer Server” on page 57.

Install and configure Avid Interplay Media Services. See “Installing Software on
the Media Services Server and Media Services Provider Servers” on page 58.

Install and configure CaptureManager . See “Installing Software on the
CaptureManager Server” on page 68. See the Avid CaptureManager Installation
and Configuration Guide. Also set up and configure any Avid Low Res Encode
systems. See Avid Interplay Low Res Encode Setup and Configuration.
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% New features were added to CaptureManager v4.0.4. These changes are not in the
CaptureManager manuals. See the CaptureManager ReadMe for a description of the
features.

- Install and configure an Archive Engine. This is similar to installing and
configuring an Interplay Engine as described earlier in this section. For more
information, see “Installing and Configuring an Archive Engine” on page 103.

Set Up and Configure Your Avid Unity System

Before you install Interplay software, install and configure your Avid Unity system for
shared storage. See the Interplay ReadMe for the supported versions of Avid Unity ISIS and
Avid Unity MediaNetwork.

Depending on whether you have Avid Unity MediaNetwork or Avid Unity ISIS, install the
Connection Manager (MediaNetwork) or Client Manager (ISIS) on the client systems.

Workspace Names

Use the following guidelines when creating workspace names in an Interplay environment:

» Do not use special characters or spaces in your workspace names. Workspace names
should only contain ASCII characters.

»  Keep workspace name length as short as is reasonable to allow recognition of the
workspace. Longer workspace names add to the path length and can affect performance
in a large Interplay environment.

Avid Unity MediaNetwork Setup and Configuration Documentation

The main setup guide for Avid Unity MediaNetwork is the Avid Unity MediaNetwork File
Manager Setup Guide. Depending on your configuration you might also need one of the
following manuals.

For Avid Unity MediaNetwork v4.x:

*  Avid Unity MediaNetwork PortServer Setup Guide

e Avid Unity MediaNetwork LANServer EX Setup Guide

For Avid Unity MediaNetwork v5.x:

*  Avid Unity Media Engine and Avid MEDIArray XT v5.0 ReadMe
*  Avid Unity MediaNetwork Administration Guide

*  Avid Unity MediaNetwork Client Guide
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*  Avid Unity Media Engine and Avid MEDIArray XT Setup Guide
*  Avid Unity Media Engine and Avid MEDIArray XT Site Preparation Guide
»  Avid Unity MediaNetwork Performance Guide

Avid Unity ISIS Setup and Configuration Documentation

See the following ISIS documentation:

*  Avid Unity ISIS System Setup Guide

*  Avid Unity ISIS Administration Guide
*  Avid Unity ISIS ReadMe

% The Avid Unity ISIS System Setup Guide contains a section on upgrading to ISIS v1.4. For
additional information, see “Updating Intel Drivers on Cluster Systems” on page 18.

Network Considerations

This section contains topics related to setting up your Interplay network environment.
Computer Names

A hostname must comply with RFC 952 standards. For example, you cannot use an
underscore in a hostname. For more information, see “Naming Conventions in Active
Directory for Computers, Domains, Sites, and OUs” on the Microsoft® Support Knowledge
Base See also, “Workspace Names” on page 22.

Verify Entries on the DNS Server

Interplay Framework can become sluggish and unstable if there are incorrect entries in the
DNS server for any of the computers in the Interplay environment. Symptoms include
excessive CPU usage by the Interplay Framework Lookup service and Interplay Diagnostics.
The tree view in the Interplay Service Configuration or Health Monitor might also fail to
populate if there are incorrect DNS entries.

Make sure that you correct any errors in DNS entries for name to IP resolution.
Configure The DNS Server to Support Reverse Lookup

If DNS is not configured for Reverse Lookup, Interplay Framework can not resolve IP
addresses to host names. Symptoms include tree views failing to populate in the Interplay
Service Configuration, Interplay Diagnostics, and Health Monitor.

Make sure the DNS server is configured to support Reverse Lookups.
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Non-DNS Environments

In an non-DNS environment, you must configure a host file on all systems, including Avid
Low Res Encode systems. This is necessary so the Interplay Framework can list the systems
in its client applications, such as the Interplay Service Configuration or Health Monitor.

Computers with Multiple Network Interfaces

Computers that have multiple network interfaces in use must be entered in DNS so that all IP
addresses have the exact same hostname.

If you have multiple network interfaces on a computer and one is not used, use the Device
Manager to disable the interface. If not, the computer might have problems communicating
with the rest of the Interplay workgroup.

Configuring an Avid Unity ISIS System

On an Avid Unity ISIS system, if your network extends outside of ISIS Zone 1, you must
configure a router to communicate between the two VLAN® systems.

Know Where Your Subnets Are on the Network
Create a system diagram that identifies the subnets on your Avid Interplay environment. You

have the following choices for allowing Interplay clients to communicate across subnets:

*  Use Unicast Discovery. See “Connecting Systems Directly to the Lookup Service” on
page 116.

* Install and configure the Multicast Repeater software on each subnet. See “Configuring
a Multicast Repeater” on page 117.

Diagnosing Interplay Framework Problems

Use the System Check tab of the Avid Interplay Workgroup Properties tool to detect and
diagnose problems in your Interplay environment.

Time Synchronization

24

If you already have a system in place to maintain Time Sync on your network, you can
continue to use that system, or you can use the Interplay Framework Time Synchronization
service to perform the same task.

The Avid Time Synchronization Service enables time synchronization between different
machines in a workgroup. The Time Synchronization Service can operate in either Master
mode or Slave mode. In Master mode, the service retrieves a reference time from a
configured time source and redistributes it to the Slave services within the workgroup. The
time source can be the local PC clock, an NTP server, or an Adrienne™ timecode card
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installed in a server, such as the CaptureManager server. In Slave mode, the Time
Synchronization Service listens for time notifications from the workgroup and (optionally)
sets the local PC clock to match.

It is important to use only one time synchronism mechanism to set the local PC clocks in the
Interplay environment. If a Time Synchronization Slave service is configured to set the local
PC clock and it detects that some other mechanism (such as Windows® 32 Time Services)
changes the local clock, then the Time Sync Slave service disables itself to avoid the local
clock from jumping back and forth. The Time Sync slave also posts a Warning in the Health
Monitor.

For more information on Time Sync, see “Using Time Synchronization in an Avid Interplay
Environment” on page 108 and the Interplay Framework ReadMe at the top level of the
Interplay Installer DVD or on the Knowledge Base.

Using AirSpeed and Low Res Encode

When using Avid AirSpeed and Avid Low Res Encode to perform a dual ingest, it is
important that you lock your video signal to your timecode source. For example, you can
connect a video feed and a Time of Day timecode device into a sync device to lock the
incoming video and audio with timecode.

It is also important that the two capture devices are in sync. If the captured high-res video
and low-res video are off by a few frames, you should delay the video signal going to one of
the capture devices in order to ensure that the two video signals match. For more
information, see Avid Interplay Low Res Encode Setup and Configuration.This document is
on the Avid Interplay installer DVD. See “Installing and Configuring Avid Interplay Low
Res Encoder Software” on page 69.

User Names and Passwords Required For Avid
Unity and Product Servers

Some Avid products require user accounts on the Avid Unity system. The user names and
passwords on the Avid Unity system must match the user names and passwords on the
product server. If you are using a PortServer for Avid Unity MediaNetwork, these user
accounts must also have the same accounts and passwords on the PortServer system.

Passwords are case sensitive; the passwords must match exactly.
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Creating the Server Execution User Account
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The Server Execution User is a Windows operating system user account that is used only to
run the Interplay Engine processes. You need to specify the user name and password of the

Server Execution User account the first time that you install the Interplay Engine software.

This account must fill the following requirements:

*  The account must have local administration rights on the operating system for the
Interplay Engine Server. The Interplay Engine installation software asks you for a user
name and password and automatically creates the account. Usually this is a domain
account that has already been created.

Ideally this should be an account that human users do not use to log onto the system. If
there is ever a problem with the account, for example if someone changes the password
by mistake, users might not be able to access the Interplay database.

*  An account with an identical user name and password must have read/write access to the
Avid Unity workspaces that contain media. You use the Avid Unity ISIS or Avid Unity
MediaNetwork Administration tool to create this account.

For security reasons, do not use the Interplay Engine server operating system Administrator
account. Create a unique account that you use only as the Server Execution User. For
example, you can create an administrative account called “IPEngine.” Avoiding the word
Administrator can help indicate that this account is not used for normal administrative tasks.

The Server Execution User account is different from the Interplay Administrator account.
The Server Execution User account is used to run the Interplay Engine processes.The
Interplay Administrator account is used to manage users and the database.

You need to create an account with the identical user name and password in two or three
places, depending on your configuration:

» If your Interplay system is part of a domain, create a domain user (for example,
“IPEngine”). In an Interplay Engine cluster configuration, the Server Execution User
must be a domain user. If you want to run the Avid Interplay Engine within your domain
and also want to automatically make use of domain user management, such as Windows
Domain or LDAP, you must specify a domain user as the Server Execution User.

*  On the Avid Unity system, create an account with read/write access to the Avid Unity
workspaces that contain media. Use the Avid Unity ISIS or Avid Unity MediaNetwork
Administration tool to create the account.

*  On the Interplay Engine server, create an account during the installation process. A
Windows account with administrative rights is created automatically. Usually this is a
domain account that has already been created.
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When you install the Interplay Engine or the Interplay Archive Engine, do not select
the default Server Execution User. Create a custom user instead.

Recreating the Server Execution User

If you have already installed the Interplay Engine and need to change the user name and
password of the Server Execution User account, run the NXNServerUser.exe tool. For
information on using the tool, see “Troubleshooting the Server Execution User Account” in
the Avid Interplay Engine and Avid Interplay Archive Engine Administrator’s Guide. The
tool is located in the following directory on the Interplay Installer DVD:

Installers\AssetMgr\Tools\NXNServerUser

For information on upgrading a cluster system on which you changed the Server Execution
User, see the Avid Interplay ReadMe.

Accounts for Accessing Workspaces

To allow the Interplay Engine to access the Avid Unity workspaces, you need to set up user
accounts on both the Interplay Engine and the Avid Unity system. The user name and
password for these user accounts must match exactly on both the Interplay Engine and Avid
Unity system. If the user names or passwords are different, the workspaces are not available
in Interplay Administrator settings, such as the Editor Database settings - Voice Over Target
workspace.

The workspaces available from the Interplay Administrator settings depends on the user
account used to log in to the Interplay Administrator. For example, when you log in to the
Interplay Administrator server using the Administrator account, you can access all the Avid
Unity workspaces, provided the users are set up correctly on both the Interplay Engine and
Avid Unity system.

To access all workspaces:

1. Make sure the Administrator account on both the Interplay Engine and Avid Unity
system have exactly the same password. Passwords are case sensitive.

2. Log in to the Interplay Administrator server using the Administrator account.

To access a limited list of workspaces:

1. Make sure a user account with administrator privileges is created on the Interplay
Engine and the same user name and password are used to create a user account on the
Avid Unity system. These user accounts must have exactly the same user name and
password.

2. Log in to the Interplay Administrator server using this user account.

27



1 Installation Overview

The Avid Unity user’s workspace access privileges setting determine which workspaces
are available.

Manually Setting a Target Workspace For Voice-Over Assets

If the Interplay Administrator - Editor Database settings - Voice Over Target Workspace
menu displays “No Items to Show,” and the user and password are correctly set, you can
manually set the voice-over target workspace.

To manually set an audio voice-over target workspace:
1. Log into Interplay Access as an Administrator.

2. In the Assets browser, right-click the database node (for example, AvidWG) and select
Advanced > Get/Set Property.

The Get/Set Property dialog box opens.
3. On the Get/Set Property tab, in the Name text box, type:
com.avid.worgroup.settings.VoiceOver.TargetWorkspace

Make sure you type the Property name exactly, because Property names are case
sensitive.

4. In the Value text box, type the name of the workspace you want to use as the target
workspace for audio voice-over assets.

5. Click Apply.

6. Click OK.

Accounts for Using Deletion

To allow deletion in an Interplay environment, you must set up the following user accounts.
You can use any user name and password for these accounts, but the user name and
passwords must match exactly on all servers.

*  Avid Unity system

- Avid Unity user with administrator privileges for Interplay Engine. This user must
not be the Administrator account.

* Interplay Engine server
- Microsoft Windows user with administrator privileges
- Interplay Engine Server Execution user

When installing the Interplay Engine on the Interplay Engine server, select the
Custom User Account option to create the Avid Interplay Engine Execution User.
The Server Execution User is the Microsoft Windows user that runs the Avid
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Interplay Engine (the Avid Interplay Engine Execution User). This user needs to
have administrative access to the file server. The installer makes this user a local
administrator on the Avid Interplay Engine server. For more information, see
“Creating the Server Execution User Account” on page 26.

Accounts for Using AirSpeed Server

When you are adding an Avid AirSpeed server in an Interplay workgroup, the Interplay
Engine server needs a Windows user account (with Admin rights) with the user name
airspeed and password avid. You must use these exact user and password names. For
additional information, see “Configuring Avid AirSpeed in Avid Interplay Adapter” on page
126.

Accounts for Using Interplay Transfer

When you are adding Interplay Transfer into an Interplay workgroup, the Interplay Engine
server requires a user for the Interplay Transfer. Create the following user on the Interplay
Engine server:

*  User name: transfermanager

e Password: avid

Accounts for Avid Editing Applications, Assist, and Instinct

The following limitations exist for Interplay v1.2.3:

Avid editing applications such as NewsCutter®, Media Composer®, and Symphony™
Nitris® that are part of an Interplay environment can use a regular Windows User login.
However, when you install the application, you must first log in as an Administrator,
install the application, and initially launch the application as an Administrator. See the
Avid editing application ReadMe for details.

» Interplay Assist and Instinct have similar limitations: When you install the application,
you must first log in as an Administrator, install the application, and initially launch the
application as an Administrator. You can then subsequently run the application as a
regular User.

* In Avid Unity MediaNetwork, do not use the same login to log into Windows and to log
into the Connection Manager for Avid Unity. For more information, see the Interplay
ReadMe.

Check the Interplay ReadMe for any changes to the Windows login permissions.
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Required Application Keys

A

The following systems require a hardware application key (also known as a dongle):

» Interplay Engine server - also requires a software application key. For more information,
see “Installing Software on the Interplay Engine Server” on page 43.

* Interplay Media Services
* Interplay Transfer

e Interplay Transcode provider system (for any Transcode provider that is not run on the
Interplay Media Services system)

* Interplay Archive provider (for any Archive provider that is not run on the Interplay
Media Services system)

*  Avid editing applications
Do not lose the USB application key. Your software does not function without it. If you

lose your application key, you must purchase another key from Avid at the full market
cost of your software.

Software Installed on Avid Interplay Systems
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The topics in this section list the software components installed on the Avid Interplay clients
and servers. The Avid Interplay Installer combines components together to make the
installation straightforward for an individual system. Depending on the size of your
configuration, you need to make decisions regarding the software you will install on the
Interplay Engine and the Media Indexer server.

Graphic Editor

In the client software table, the term Graphic Editor refers to a system used for graphics or
other work that does not involve Avid assets. Examples of these file assets are Adobe®
Photoshop® files, Microsoft Office files, and other file assets that are useful in an Interplay
environment. They can be checked into the Avid Interplay database and made available to
other users. Graphic Editor systems use Avid Interplay Access. For more information, see
the Avid Interplay Access User’s Guide.



Software Installed on Avid Interplay Systems

Interplay Framework Components

A

There are two important steps when you install the Interplay Framework software:
*  Provide the correct workgroup name when prompted.

The Workgroup name is case sensitive. You can use the Avid Interplay Workgroup
Properties tool to change the workgroup name after the install if necessary.

* Select the correct services to install on the system.

When you install software on the client systems, the installation program automatically
selects the components that you need for a client system. The following are the basic
services:

*  Core Components

*  Configuration Utility

» Diagnostic Log Viewer

*  Health Viewer

*  Machine Monitor

* Time Synchronization (see “Using Time Synchronization in an Avid Interplay
Environment” on page 108)

The following services are critical to the Interplay environment and must be installed on at

least one system (usually on the same system).

*  Avid Lookup Service - See “Installing the Lookup Service on a Separate Server” on
page 113.

*  System Configuration (one per Lookup Service)
If you have more than 10 clients in your Avid Interplay Framework environment, Avid

recommends that you put the Interplay Framework Lookup Service on a separate server
such as a General Purpose Server.

The following services are optional depending on whether you use them in your Interplay
environment:
*  Multicast Repeater

Optional when Interplay clients are on a different subnet from the shared storage Media
Indexer. See “Configuring a Multicast Repeater” on page 117 and “Connecting Systems
Directly to the Lookup Service” on page 116.

*  SNMP Gateway
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A

The Avid SNMP Gateway service can capture a snapshot of a workgroup by mirroring
all of the health information in a simple network management protocol (SNMP)
management information base (MIB). It uses an SNMP daemon to send traps to an
SNMP trap receiver whenever a warning or critical system condition occurs. It captures
a snapshot of the workgroup, reflects it in an SNMP MIB, and makes that information
available to SNMP manager applications, such as HP® OpenView, by acting as an
SNMP agent that responds to requests.

Email Alerter

The Email Alerter is an e-mail daemon, which sends e-mail notifications to a
configurable list of recipients when any of the health parameters—on systems in the
workgroup—are at warning or critical health level. The Avid Lookup service gathers the
health level information from systems within the workgroup.

The Avid Email Alerter is configured using the Avid Interplay Service Configuration
application.

The SNMP Gateway and Email Alerter are resource-intensive applications. If you plan
to use those services, don’t install them on the Media Indexer or Interplay Engine
servers. If necessary, use the Interplay Workgroup Properties tool to disable

the services.

Software Installed on Interplay Clients

%

The following table shows the software that is installed on the Interplay client systems.

In the following tables, X indicates a required component and O indicates an optional
component.

Software Installed on Interplay Clients

Interplay Interplay Avid Graphic CaptureManager

Software Instinct Assist Access Editor Editor Client
Interplay Assist X X (0)?

application

Avid Unity client X X O X 0)

Instinct application X

Editing application X

CaptureManager X
application
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Software Installed on Interplay Clients (Continued)

Interplay Interplay Avid Graphic CaptureManager

Software Instinct Assist Access Editor Editor Client
Interplay Access X X X X

Media Indexer X

Interplay Transfer client  X° X? X (0) X (0)

Interplay Framework®
Core Components X X X (0) X X

Avid Lookup service

Configuration Utility X (0)¢ X (0) X (0) X X
Diagnostic Log Viewer X (O) X (0) X (0) X X
Health Viewer X (0) X (0) X (0) X X
Machine Monitor X (0) X (0) X (0) X X
System Configuration

Time Synchronization X X X (0) X X

Interplay Media Services
ProEncode Client X(0)

Do not run Assist and an Avid editing application at the same time on the same computer.

Installed automatically on Avid Assist and Instinct as part of the software application install.

For additional information, see “Interplay Framework Components” on page 31.

On a large system, you might want to disable optional Framework services on Instinct and Assist clients.

/ao op
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Software Installed on Interplay Servers

Software Installed on Interplay Servers (excluding Media Indexers)

Interplay Interplay Media Capture General
Interplay Archive Media Transfer Services Manager Purpose
Software Engine Engine Services Engine Provider Server Server
Interplay Engine X
Interplay Access X X X X X
Interplay Adapter X2 xPb X (0)
Interplay Archive X
Engine
CaptureManager X
server
Interplay Transfer X
Interplay Transfer X¢
client
Media Indexer X (0)*
Interplay Framework
Core Components X (0)¢ X X X X X (0)
Avid Lookup X (0)¢ X (0)
Service
Configuration X (0)¢ X X X X X (0)
Utility
Diagnostic Log X (0)¢ X X X X X (0)
Viewer
Health Viewer X (0)¢ X X X X X (0)
Machine Monitor X (O)¢ X X X X X (0)
System X (0)¢ X (0)°
Configuration
Time X (0)¢ X X X X X (0)
Synchronization
Multicast Repeater X (0)¢ X (0)
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Software Installed on Interplay Servers (excluding Media Indexers) (Continued)

Interplay Interplay Media Capture General
Interplay Archive Media Transfer Services Manager Purpose
Software Engine Engine Services Engine Provider Server Server
Interplay Media X
Services
ProEncode Provider X (0)
Transcode Provider X (0)
Archive Provider X (0)
a. On a non-cluster system with 10 or fewer Interplay clients. Do not install on a cluster system.
b. See “Interplay Adapter and AirSpeed” on page 127.
c. Starting at CaptureManager v4.0.4, The Interplay Transfer client is not required on a CaptureManager server.
d. Do not install Interplay Framework software on a cluster or on a single engine system with more than 10 clients.
e. Install only one System Configuration service per Lookup server. Additional services can affect performance.

Software Installed on Media Indexer Servers

The following table lists the software installed on different servers depending on the Media
Indexer’s use in the Interplay environment.

Software Installed on Avid Media Indexer Servers

On Same System as Member of a High Delegate Media

Software Interplay Engine?® Availability Group Indexer
Interplay Engine X

Interplay Access X

Interplay Adapter xP

Media Indexer X X X

Interplay Framework
Framework Core X X X
Lookup service X¢
Configuration Utility

Diagnostic Log Viewer X X
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Software Installed on Avid Media Indexer Servers (Continued)

On Same System as  Member of a High

Delegate Media

Software Interplay Engine?® Availability Group Indexer
Health Viewer X X X
Machine Monitor X X X
System Configuration xed
Time Synchronization X X X
Multicast Repeater® X(0) X(0)

SNMP Gateway®

Email Alerter

a. This configuration is intended for systems with fewer than 10 clients. For larger systems, do not install the Media
Indexer on the Interplay Engine.

Only on a system with 10 or fewer clients. Do not install on an Interplay Engine cluster system.

Only on a system with 10 or fewer clients. Do not install on an Interplay Engine cluster system.

Install one per Lookup service and install on the same system as the Lookup service.

An option when you have multiple subnets. You can alternatively use Unicast Discovery.

SNMP Gateway and Email Alerter are resource intensive applications. Do not install the services on a Media Indexer,
Avid Interplay Engine, or Interplay Archive Engine.

™o e o
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Different Types of Media Indexers

There are four basic ways to configure a Media Indexer:

*  The leader of a High Availability Group. The leader (also known as the President) can
index shared storage and it can also monitor other Media Indexers. On a small
configuration, the Media Indexer software might be installed on the Avid Interplay
Engine. In this case, configure a High Availability Group with one member configured
on the Interplay Engine.

You always need a High Availability Group to monitor shared storage, even if it is a group of
one.

» Additional members of a High Availability Group. Members that you add to a High
Availability group provide load balancing for the leader and allow you to add additional
clients. For example, if you have more than 50 clients in your Interplay environment,
then you should have two Media Indexers in the High Availability Group: one
configured as the leader and a second added for load balancing.

*  Delegates.If you have a large number of files, you might want to assign different Media
Indexers to monitor specific portions of shared storage. In this case the group leader
monitors the delegates. For more information on configuring delegates, see Avid
Interplay Best Practices.

*  The Media Indexer on each Avid editing application system. These local Media Indexers
connect to the High Availability Group.

Avid Interplay Assist and Avid Instinct do not require a local Media Indexer. They
automatically connect to the High Availability Group in the Interplay environment. You use
the Server Hostname Settings view in the Interplay Administrator tool to identify the
Workgroup name. The system automatically connects to the High Availability Group for the
workgroup. The workgroup name is case sensitive and must match the workgroup name
identified in the Interplay Workgroup Properties tool.

For information on the maximum number of files that a Media Indexer can monitor, see Avid
Interplay Best Practices and the Avid Interplay ReadMe.

37



1 Installation Overview

38

The following illustration shows two Media Indexers in a High Availability Group and three
Media Indexers configured as delegates to the High Availability Group.

Local Media Indexer

connects to High
Availability Group | E “
p— || — Avid editing application

Media Indexer 2 is a member of the
group and provides load balancing
and redundancy for the leader.

Hlgh Availability Group

Monitor three Media Indexer 1 (leader) Media Indexer 2

Media Indexer Delegates

Delegate Media Indexers monitor
shared storage

Media Indexer 3 (delegate)

Storage A

Media Indexer 4 (delegate)
Maximum number of files

Storage B

Media Indexer 5 (delegate)

Maximum number of files

Storage C

- Non-indexed files such as
files created by Graphic
artists.

Storage D



Using the Interplay Installer

Shutting Down a Media Indexer System

Do not shut down the Media Indexer while it is scanning files. If you do, the Media
Indexer might have to rebuild its cache when it starts up again. This can take a long
time on a large system. You can use the Health Monitor to determine whether the
Media Indexer is scanning files.

In a small configuration (10 or fewer users), you can have the Media Indexer that monitors
shared storage on the same system as the Avid Interplay Engine. If the Media Indexer needs
to rebuild its cache on this type of configuration, the Interplay Engine might become
unresponsive during the operation. Note that this does not happen when the Media Indexer is
scanning drives, only when it needs to completely rebuild its cache.

To determine whether a Media Indexer is scanning files:

1. Launch the Health Monitor and navigate to the system that is running the Media Indexer
that you want to shut down.

2. Click Avid Interplay Media Indexer

3. Open the Avid Interplay Media Indexer pane.
4. Check the value of the “Pending Files (scan)” field.

If the Media Indexer is not scanning files, then it is safe to shut it down.

5. To shut down the service, use the Avid Interplay Workgroup Properties tool.

Using the Interplay Installer

The Interplay Installer lets you do the following:

» Install the software for the following Interplay servers:

Interplay Engine
Archive Engine
Interplay Media Services
Interplay Transfer
Media Indexer

CaptureManager

» Install the software required to support the following Interplay clients:

Interplay Access
Avid Instinct

Avid Interplay Assist
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- Avid editing applications such as Avid NewsCutter Adrenaline, NewsCutter XP,
Media Composer, and Avid Symphony Nitris.

- Avid Interplay Adapter
- CaptureManager Client
- Pro Tools Interplay Option
*  Perform custom installations of the following software:
- Interplay Framework Services
- Interplay Access

- Interplay Media Services and Transfer Status
You can also browse the DVD and select individual installers.

The Interplay Installer allows you to navigate to a window that shows exactly which
components must be installed on an individual server or client. You run each installer
separately from the installation window.

Additional Installers on the Interplay Installer DVD
The following installers are also on the DVD although not accessible through the Installer

user interface:

» Avid Low Res Encode software: see “Installing and Configuring Avid Interplay Low
Res Encoder Software” on page 69.

«  The installer for Mac® OS® X is located on the Avid Interplay Installer DVD in the
following folder:

Installers\JXDK\Mac_Installer

For more information, see “Macintosh Installer for Interplay Access Client” on page 75.



ﬂ Installing Software on Interplay Servers

The following topics describe the installations of the Interplay software on the servers:

Starting the Installation

Installing Software on the Interplay Engine Server

Installing Software on the Interplay Transfer Server

Installing Software on the Media Services Server and Media Services Provider Servers
Installing Software on an Avid Interplay Media Indexer Server

Installing Software on the CaptureManager Server

Installing and Configuring Avid Interplay Low Res Encoder Software

For information on the order of installation and configuration, see “Installation Check List
and Installation Steps” on page 18.



2 Installing Software on Interplay Servers

Starting the Installation

To start the Interplay Installer:
1. Insert the Interplay Installer DVD and double-click Launch.exe.

The Main Menu window opens.

The Main Menu window allows you to select the installers required by a particular Interplay
component. The list is divided into Interplay clients, servers, and individual optional
installers.
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Installing Software on the Interplay Engine Server

These instructions are for a system with a single Interplay Engine or Interplay Archive
Engine. If you are installing software on machine with cluster services, see the Avid
Interplay Engine Failover Guide.

To install the Interplay Engine software:

1. Insert the Interplay Installer DVD into the DVD drive on the Interplay Engine system.

The Main Menu window opens.
2. Click Servers.

The Install Servers window opens.

Items with three dots open a new window. Items without three dots start an installer.
3. Click Avid Interplay Engine.

& If you are upgrading an Interplay Engine, see the Interplay ReadMe before
proceeding. The Readme contains any specific instructions for upgrade the Interplay
Engine for a particular release.

The Install Avid Interplay Engine window opens.
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The Interplay Engine requires the following software:

- Avid Interplay Engine — The full Interplay Engine software. See “Installing the
Avid Interplay Engine Software” on page 45.

- Avid Interplay Access — Required to communicate with the Interplay Engine
database. Installing Interplay Access also installs the Interplay Administrator. See
“Installing Avid Interplay Access” on page 55.

- (Option) Avid Interplay Adapter — Required for capturing with AirSpeed. Only
install on an Interplay Engine if there are fewer than 10 clients in your Interplay
environment and you are not using a cluster for the Interplay Engine. See “Installing
Avid Interplay Adapter” on page 55.

% It is important to determine where to install the Interplay Adapter. See “Interplay Adapter
and AirSpeed” on page 127. Do not install the Interplay Adapter on an Interplay Engine
cluster system or on an non-cluster Engine that has more than 10 Interplay clients.

- (Option) Avid Interplay Auto Archive, Auto Transcode, and Auto Transfer —
Required for Auto Archive, Auto Transcode, and Auto Transfer. For more
information, See the Avid Interplay Media Services Setup and User’s Guide.

4. Perform the installation in the order shown in the above list. You have to reboot the
server after the Interplay Engine installation.
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Installing the Avid Interplay Engine Software

The first time you install the Avid Interplay Engine software, you must select Custom
installation. Selecting Custom installation lets you specify the Server Execution User and
other configuration information correctly.

If you are upgrading, you can select Typical installation, which uses the existing settings.

If you installing or upgrading a cluster system, see the Interplay ReadMe and the Avid
Interplay Engine Failover Guide.
To install the Avid Interplay Engine software:

1. Before you begin, do the following:

P  Make sure that the Interplay Engine application key is installed on the server
system. For more information, see “Required Application Keys” on page 30.

The Interplay Engine also requires a software license. Install this license after
installing the Interplay Engine software, as described at the end of this procedure.

P Make sure you have created matching accounts on the Interplay Engine system and
the Avid Unity system. You need to type the user name and password during
installation to create the Server Execution User. See “Creating the Server Execution
User Account” on page 26.

P Close all Windows programs.
2. Insert the Interplay Installer DVD into the DVD drive on the Interplay Engine system.
The Main Menu window opens.
3. Click Servers.
The Install Servers window opens.
4. Click Avid Interplay Engine.
The Install Avid Interplay Engine window opens.
5. Double-click Avid Interplay Engine.

6. In the Welcome dialog box, read the information about the installation of the Apache
server. Click Next.

7. Read the license agreement information and then accept the license agreement by
selecting “T accept the agreement.” Click Next.

The Specify Installation Type dialog box opens.
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;‘?—_ Avid Interplay 1.0.0.4067 Engine

Specify Installation Type

Fleaze specify the installation type.

r— Installation Type

= Typical Installz the typical [default] components of the software. |f pou
have an Avid Interplay Engine already installed, the options
defined previously are uzed instead.

Allows pou to specify all available options for the installation.
' Custom Thiz mode is recommended only for advanced users and
administratars.

Awid Interplay

Cancel

8. Select one of the following and click Next:

p Ifthis is a new installation, select Custom. This ensures that you identify the Server
Execution User required by the Interplay Engine.

» Ifthis is an upgrade, select Typical and proceed to step 18. (Both the Typical and
Custom installation use the existing settings.)

The Specify Destination Location dialog box opens.

#2 Avid Interplay 1.0.0.4067 Engine =
Specify Destination Location S
A

Setup will inztall Avid Interplay 1.0.0.4067 Engine in the following folder.

Ta inztall into & different folder, click Browse, and select another folder.

IE:\Program FilezAvidvivid Interplay Engine Browse... |

Awid Interplay

" Destination Folder

Cancel |

9. Specify the destination folder and click Next.
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The Destination Location is the folder in which the Avid Interplay Engine program files
are installed. In most cases, keep the default, which installs the files in an Avid Interplay
Engine subfolder in the Program Files folder.

The Specify Default Database Folder dialog box opens.

42 Avid Interplay 1.0.0.4067 Engine =
Specify Default Database Folder — ["e )
-

Fleaze zelect the default Avid Interplay database folder. The default databaze folder will be
shared throughout the netwark.

If you want to zet the default folder on another computer, enter the path to the share manually
[i.e. "S\FILESERYERYnetwork_shareh'").

" Default D atabase Folder

ID:\Workgroup_D atabazes Browse... |

Awid Interplay

< Back Cancel |

10. Accept the default folder and click Next.

The database folder is the folder in which the database is created and stored. This
location must be local, that is, the database folder must be installed on the Interplay
Engine server. No other configuration is supported. By default the database folder is
created at the root of the D: drive as D:\Workgroup_Databases. All access rights are set
automatically.

If you previously installed the Interplay Engine software, this field displays the share
name that appears in the next dialog box.

Avid recommends that you store source files for file assets on a shared storage workspace
rather than a local drive. To do this, you must perform extra steps after the installation. See
“Recommendations for Database Storage” in the Avid Interplay Engine and Avid Interplay
Archive Engine Administrator’s Guide.

The Specify Share Name dialog box opens.
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;‘?—_ Avid Interplay 1.0.0.4067 Engine x|

Specify Share Name S

Keep the default or designate another name to the new shared directory. Please do not use
any wildcards or special characters.

Please uze a "$" at the end to hide the share in the file system.

Share Mame
’7 IW’G_D atabazed

Awid Interplay

Cancel

11. Accept the default share name and click Next.

By default, the share name is “WG_Database$.” The “$” at the end makes the share
invisible if you browse through the network using Windows Explorer. For security
reasons, Avid recommends keeping the default setting and using a “$” at the end of the
share name. With this default setting, the folder “D:\Workgroup_Databases” on the Avid
Interplay Engine computer is shared under the name “WG_Database$.”

The Specify Configuration Server dialog box opens.

#2 Avid Interplay 1.0.0.4067 Engine =
Specify Configuration Server S
=

Fleaze specify the Avid Interplay Central Configuration Server [CCS).

The CCS iz a central Avid Interplay Engine that provides cross-database information.

Central Configuration Server:

& This Avid Interplay Engine

" &nother Avid Interplay Engine

Awid Interplay

< Back Cancel |

12. Select the Interplay Engine you want to use as the Central Configuration Server and

click Next.
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The Central Configuration Server (CCS) is an Interplay Engine with a special module
that is useful if you are working in an environment that includes more than one Interplay
Engine (including an Interplay Archive Engine). However, even if you are working in an
environment with one Interplay Engine, you need to specify a CCS.

Select one of the following:

» This Avid Interplay Engine: Specifies that the Interplay Engine that you are
installing should be the CCS. Click Next.

P  Another Avid Interplay Engine: Specifies that a previously installed Interplay
Engine should be the CSS. An additional dialog box opens. Type the name of the
Interplay Engine to be used as the CCS and click Next.

If you want to specify another Interplay Engine, you must specify an Interplay Engine
that is already installed. If you have not yet installed the desired Interplay Engine,
specify the current Interplay Engine, install the desired Interplay Engine, and then
change the CCS through the Interplay Administrator. See “Using a Central
Configuration Server” in the Avid Interplay Engine and Avid Interplay Archive Engine
Administration Guide.

If you specify an Interplay Engine that is not yet installed, you might not be able to log
onto the system. See “Troubleshooting Log-in Problems” in the Avid Interplay Engine
and Avid Interplay Archive Engine Administration Guide.

The Server Execution User dialog box opens.

;‘?—_ Avid Interplay 1.0.0.4067 Engine

x|
Server Execution User o

Fleaze specify the user account pou want to uge to run the Avid Interplay 1.0.0.4067 Engine.

*f'ou can either specify the default server uzer account [AYID_WORKGROUP_USER] or you
cah enter a custom uzer account.

‘r'ou have specified thiz server az your central configuration server, so you must select a
"cugtom wger account' within the Windows domain if you want to uze Windows domain
authentication. Othenwise vou can keep the "Default server user account’ or select any other
cuztam user account.

Server Execution User:

" Default server user accaunt

¢ Custom user accaunt

Awid Interplay

Cancel

13. Select Custom user account and click Next.

49



2 Installing Software on Interplay Servers

The Server Execution User is a Windows account that has administrative access to the
Avid Interplay Engine. This account also needs to have administrative access to the
shared storage workgroup. Avid requires that you create a custom user account. For
more information, see “Creating the Server Execution User Account” on page 26.

The Specify Server User dialog box opens.

;‘?—_ Avid Interplay 1.0.0.4067 Engine x|
Specify Server User S
=S

Fleaze specify the user account pou want to uge to rn the Avid Interplay 1.0.0.4067 Engine
and the password. |f the user iz not available locally, this program will try to create it I you want
to uze a user account from a domain, please enter the user like: "MYDOMAINAMYLISER"™

Server Execution User

User Mame: IAdministrator

Password: I

Confirmn Password: I xxxxxxxxxxx

Awid Interplay

Cancel |

a. Type a local user, for example, “IPEngine,” or type a domain user, such as
“MYDOMAIN\IPEngine.” Make sure this user name exactly matches the user
name of an Avid Unity account with administrator privileges.

b. Type the password. The installer cannot check the password you type in this dialog
box. Make sure that the password exactly matches the password for the Avid Unity
user with administrator privileges. If the user name and password do not match
those of the Avid Unity user, the Avid Interplay Engine will not run properly.
Confirm the password.

% You can change the Server Execution User after installation. See “Troubleshooting the
Server Execution User Account” in the Avid Interplay Engine and Avid Interplay Archive
Engine Administration Guide.

c. Click Next.
The Specify Server Name dialog box opens.
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;‘?—_ Avid Interplay 1.0.0.4067 Engine

Specify Server Name

Fleaze enter the Avid Interplay 1.0.0.4067 Engine host name, under which this machine will be
reachable from the Avid Interplay Clients.

*f'ou can enter the name of this computer, which is entered as default, such as "LISA"
If you uze Avid Interplay Access on MAC or Unix systems and these systems can not resolve

the computer name, you can alzo enter the static [P adress of this computer, such as
"192.168.230.1".

Server Mame
MDDEWG

Awid Interplay

Cancel |

14. Specify the server name as it appears on the network and click Next.

By default, the computer’s name is specified as the server name. Interplay clients use
this name to identify the server. If there are clients in your network that are unable to
resolve hostnames to IP addresses, you have to specify the server’s IP address here. In
this case, the server needs a static [P address; be sure to configure your DHCP server
accordingly.

% A hostname must comply with RFC 952 standards. For example, you cannot use an
underscore in a hostname. For more information, see “Naming Conventions in Active
Directory for Computers, Domains, Sites, and OUs " on the Microsoft Support Knowledge
Base.

The server name entered should not be more than 15 characters. Server names longer than
15 characters will be truncated and might cause problems with client connections if there is
more than one machine in the network with the same truncated name.

The Specify Preview Server Cache dialog box opens.
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;‘?—_ Avid Interplay 1.0.0.4067 Engine

Specify Preview Server Cache

Fleaze specify the Avid Interplay Engine preview server cache folder.

To zet up the preview server cache folder on another computer, select the Browse button and
enter the path manually [i.e. “WFILESERVER network_sharePreviewServer']. The preview
zerver cache folder iz normally located inside the default database folder.

"Preview Server Cache Folder

ID:\Workgroup_D atabazes\PreviewServer Browse... |

Awid Interplay

Cancel |

15. Accept the default location and click Next.

Interplay Access lets you view a thumbnail image or other representation of a file asset.
This feature requires a special cache folder. The default folder for the preview server
cache is named PreviewServer and is installed in the default database folder.

The Enable E-mail Notification dialog box opens.

#2 Avid Interplay 1.0.0.4067 Engine =
Enable E-mail Notification S
-

The ‘Workgroup Server is able to zend e-mail notifications to pour adminiztrator when special
events, such as "Disk Full" ete., ocour. Would you like to activate this feature?

v Enable e-mail notification on server events ‘

Awid Interplay

< Back I Mest » I Cancel |

16. Enable email notification and click Next.
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The email notification feature sends emails to your administrator when special events,
such as “Disk Full” and “Out Of Memory,” occur. See “Configuring the Server Event
Manager” in the Avid Interplay Engine and Avid Interplay Archive Engine
Administration Guide for details on configuring the email notification.

The E-mail Notification Details dialog box opens.

;‘?—_ Avid Interplay 1.0.0.4067 Engine =
E-mail Notification Details 0
¥ 1
N
Fleaze specify the details for the e-mail notification. Make sure that you enter the corect SMTR
server IP.
E-mail Detail
Recipient e-mail address: ladminiztrator@imydonnain, com|
Sender e-mail address: IWorkgroupServer@mydomain.c:om
SMTF server IP: |123.123.123.123
¥ Send critical notifications also to Avid Suppart

Awid Interplay

< Back I Mest » I Cancel

17. Supply the following information:

a. Type the administrator’s email address and the email address of the server that is the
sender. If an event such as “Disk Full” occurs on the server, the administrator
receives an email from the sender’s email account explaining the problem, so that
the administrator can respond to the problem.

b. Type the static IP address of your SMTP server. The notification feature needs the
SMTP server in order to send emails. If you do not know this IP address, ask your
administrator.

c. (Option) If you also want to inform Avid Support automatically through email if
problems arise, select the option “Send critical notifications also to Avid Support.”

d. Click Next.

The installer modifies the file Config.xml in the
Avid Interplay Engine\Data\Server\Config directory with your settings. The Ready to
Install dialog box opens.

18. If you are ready to complete the installation, click Next.
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;‘?—_ Avid Interplay 1.0.0.4067 Engine

Ready to Install

“Y'ou are now ready to install Avid Interplay 1.0.0.4067 Engine.

Prezz the Mext button to begin the ingtallation or the Back button ta reenter the installation
infarmation.

Awid Interplay

< Back Cancel |

All necessary components are installed. It might be necessary for the installation
program to install additional components, such as Adobe Reader.

If any system libraries on your machine need to be upgraded to complete the installation
process, the installation program asks you to reboot your machine. Save all your open
documents, close all applications, and then click the OK button to reboot.

The installation finishes and the Installation Completed dialog box displays the success
or failure of each installation.

#2 Avid Interplay 1.0.0.4067 Engine =
Installation Completed S
=S

Awid Interplay 1.0.0. 4067 Engine has been successfully installed.

OF: The user "AVID_WORKGROUP_USER" will be uzed as Server Execution User,

OK: The shared directory "\LISANMWG_Databased” will be used as default database direc
OK: The preview server cache dir iz located at "D:\workaroup D atabases\PreviewServe
OF: The service “Avid Workgroup Server Browser" has been installed successfully!

OF: The service "Avid Workgroup TCP COM Bridge" has been installed successfully!

OF: The service “Avid_‘Workgroup_Preview_Server' haz been installed successfully!

OF: Thiz server itzelf acts as Central Configuration Server [CCS). -

Press the Finish button to exit this installation.

Awid Interplay

Cance!

19. Click Finish.
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A dialog box requesting a reboot opens. A message with instructions on how to fix any
installation problems also appears.

20. Click OK to reboot the machine.

21. Enable a permanent license key. See “Managing Licenses” in the Avid Interplay Engine
and Avid Archive Engine Administration Guide for instructions. Make sure that you
obtain and load the Interplay Engine license file promptly. The license key must match
the application key (dongle) for the Interplay Engine server.

Installing Avid Interplay Access

You must install Avid Interplay Access on the Interplay Engine. Avid recommends that you
accept the defaults. If users at your site will be checking in Microsoft Office or Adobe
Photoshop assets (file assets), you can optionally select these options as part of the install
set. For more information, see the Avid Interplay Integration Guide for Adobe Photoshop
and Microsoft Office.

Installing Avid Interplay Access also installs the Avid Interplay Administrator.

To install Interplay Access:
1. In the Install Avid Interplay Engine window, double-click Avid Interplay Access.
After the installer starts, the Introduction dialog box opens.
2. Close down all other programs, then click Next.

3. Complete the installation by accepting the defaults. If you want to install the Microsoft
Office and Adobe Photoshop plug-ins, accept the default paths.

4. When you finish the installation, the installation program might require you to reboot
the system.

Installing Avid Interplay Adapter

When you install Interplay Adapter (also known as the MM Adapter) on the Avid Interplay
Engine system, it automatically connects to the Interplay Engine on that system.

If you use CaptureManager, Avid recommends that you install the Interplay Adapter on the
CaptureManager server to improve performance on the Avid Interplay Engine system. For
additional information on where to install the Interplay Adapter, see “Interplay Adapter and
AirSpeed” on page 127.

& Do not install Interplay Adapter on an Avid Interplay Engine cluster system.

If you install Interplay Adapter on a system other than the Interplay Engine, you must
manually edit a file to identify the Interplay Engine system.
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To configure Interplay Adapter to recognize Interplay Engine on a different system:
1. Use an application such as Notepad to edit the following file:
C:\Program Files\Avid\Avid Interplay Adapter\jakarta-tomcat\omm\RAM\mmserver.ini

2. Edit the following line, by replacing the text “localhost” with the computer name of the
system running the Avid Interplay Engine:

env.ABServer=localhost

For additional information on configuring an Interplay Adapter with AirSpeed and
CaptureManager, see “Configuring Avid AirSpeed in Avid Interplay Adapter” on page
126.
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Installing Software on the Interplay Transfer

Server

To install the Interplay Transfer server and related software:

1. Click Servers in the Main Menu window and then click Avid Interplay Transfer Server.

The Install Interplay Transfer Engine window opens.

2. Install the following components on the Interplay Transfer Server:

Avid Interplay Framework for Server — The installer automatically installs the
components required for an Interplay Transfer application.

Avid Interplay Access — Allows for easy access to the Interplay Engine. This also
installs the Interplay Administrator.

Avid Interplay Transfer server.

Avid Interplay Media Services and Transfer Status — Allows you to monitor
Interplay Transfer jobs as well as Interplay Media Services jobs.

(Option) Avid Interplay Transfer Cache — Allows you to install only the Interplay
Transfer Cache.

For information on configuring the Interplay Transfer server and the Interplay Media
Services and Transfer Status application, see the Avid Interplay Transfer Setup and
User’s Guide.
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Installing Software on the Media Services Server
and Media Services Provider Servers

This section provides an overview of installing the Media Services and Media Services
Provider servers.

If this is the first time you are installing the Media Services Engine, you need to install
Microsoft SOL Server 2005 Express before you install the Media Services Engine. For
installation procedures, see the Avid Interplay Media Services Setup and User’s Guide.
To install the Interplay Media Services and related software:

1. Click Servers in the Main Menu window.

2. Click Avid Interplay Media Services in the Install Servers window.

The Install Avid Interplay Media Services window opens.

3. Click Avid Interplay Media Services.

The second Install Avid Interplay Media Services window opens.
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4. Install the following components on the Interplay Media Services system:

- Avid Interplay Framework for Client — The installer automatically installs the
components required for Interplay Media Services. When the system asks for a
workgroup name, type the name of the workgroup you set up on the Interplay
Engine.

- Avid Interplay Access — Required to configure the Interplay Media Services with
the Interplay Engine. This also installs the Interplay Administrator.

- Avid Interplay Media Services — This installation requires a restart of the system;
you might want to install it last.

If you are performing an upgrade, you do not have to reregister existing services such as the
Transcode service or Archive service.

You might have to re-create some profiles after upgrading your software. See the Avid
Interplay Media Services ReadMe.

5. After you restart the system, return to the Install Servers window and click Avid
Interplay Media Services.

The Avid Interplay Media Services window opens.
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6. You can install the following software on the Interplay Media Services system or on
another system to improve performance:

Avid Interplay Transcode - The Transcode Provider.

Avid Interplay Archive - The Archive Provider. Typically installed on its own
server.

Avid Interplay Media Services and Transfer Status — Allows you to monitor
Interplay Transfer and Interplay Media Services jobs.

Avid Interplay ProEncode Provider

(Option) Avid Interplay Auto Archive, Auto Transcode, and Auto Transfer —
Required for Auto Archive, Auto Transcode, and Auto Transfer.

(Optional) Avid Interplay Auto Archive, Auto Transcode, and Auto Transfer —
Installs the Avid Interplay Auto Media Services. The Avid Interplay Auto Archive
installation includes the Auto Archive, Auto Transcode, and Auto Transfer services.
Required for Auto Archive, Auto Transcode, and Auto Transfer.

For information on configuring Interplay Media Services, see the Avid Interplay Media
Services Setup and User’s Guide.
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Installing Software on an Avid Interplay Media
Indexer Server

For information on the different types of Media Indexer systems, see “Different Types of
Media Indexers” on page 37.

Before Installing Media Indexer Software

The following are important for a successful Media Indexer configuration:

» Before you configure Media Indexer, install the Interplay Framework software and
verify that it’s running. For additional information, see “Verifying that the Interplay
Framework Services Are Running” on page 99.

»  Before you configure Media Indexer to monitor your Avid Unity workspaces, the
workspaces must have an Avid MediaFiles folder. To create the folder, you can either
use an Avid editing application to capture or import media to the workspace or you can
manually create an Avid MediaFiles folder.

* Do not use spaces or special characters in your workspace names.

Using UNC Drive Mapping on Interplay ISIS

On Avid Unity ISIS, you must select the “Use UNC (Letterless) Drive Mapping” option on
the Media Indexers that monitor shared storage.

To set UNC Drive Mapping:
» In the ISIS Client Manager window, select Preferences and select the letterless option.

For more information, see “Installation Check List and Installation Steps” on page 18.
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Installing the Media Indexer Software

To install the Media Indexer software:

1. Click Servers in the Main Menu window and then click Avid Interplay Media Indexer.

The Install Avid Interplay Media Indexer window opens.

2. Install the following components on the Media Indexer server:

Interplay Framework for Server — Perform the installation on primary and
secondary shared storage Media Indexers. For more information, see “Turning off
Interplay Framework Services to Conserve System Memory” on page 63. You have
the opportunity to name your workgroup when the system asks for a workgroup
name. Write down the name you type and use it for other Interplay Framework
installations.

The installer automatically selects the Framework components used by an Interplay
Server.

Interplay Access — Allows for easy access to the Interplay Engine. This also
installs the Interplay Administrator.

Avid Interplay Media Indexer

If you use the installer to uninstall Media Indexer, the installer exits after the uninstall is
complete. Restart the installer to perform the installation.

62



Installing Software on an Avid Interplay Media Indexer Server

Turning off Interplay Framework Services to Conserve System
Memory

The Interplay Framework for Server installer installs all components execpt for the Email
Alerter and SNMP Gateway service. Those are resource-intensive services that you should
not install unless you specifically require them. You can turn off services to conserve system
memory depending on the type of Media Indexer you are going to set up on this system. For
more information, see “Disabling Framework Services” on page 100.

For information on which services should be installed (and running) on various systems, see
“Software Installed on Avid Interplay Systems” on page 30.

Configuring a Media Indexer to Monitor Shared Storage

This procedure describes how to configure a Media Indexer be the leader of a High
Availability Group and how to monitor shared storage. This is the basic configuration for a
small system with only one Media Indexer. The basic procedure is as follows:

1. Identify the Media Indexer as the leader of a High Availability group.
2. Identify the shared storage locations for that Media Indexer to monitor.

For more information on using Media Indexer, see the Avid Interplay Framework User’s
Guide and Avid Interplay Best Practices.

Before you configure the Media Indexer, verify that the Interplay Framework services are
running on the Media Indexer system. For more information, see “Before Installing Media
Indexer Software” on page 61.

To configure the Media Indexer to monitor shared storage:

1. Click the Start button, and then select All Programs > Avid > Interplay Framework >
Avid Interplay Service Configuration.

2. If more than one workgroup appears in the list, click the triangular opener next to your
Workgroup name to open the Workgroup list.

3. On the Hosts tab, select the system that contains the Media Indexer you want to use to
monitor shared storage, and select Avid Media Indexer.

4. Click OK when the system prompts you for the Interplay Framework administrator
password. By default, there is no password.

A message box opens asking if you want to allow the service to run with unrestricted
security.

5. Click Yes.
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@ The service that you have selected needs additional security privieges beyond those granted by default.
would you like to alow this service to run with Unrestricted Security?

The system displays the Media Indexer information in the Avid Interplay Service
Configuration dialog box.

<4 Avid Interplay Service Configuration :
File Action  Wiew Help

|l i Hosts | QE} Processes | ’ Apply ] [ Aoply To.., ] [ Reset ]
hd DDCWG Lwid Interplay Media Indexer ]
»
&, dactm “High Availabiity

» Q, doctransfer

v 2 docwg & Ioin High Awailability Group
"M il Interplay Me Group Mame: |Unity |
& avid Lookup Service weight in Group: [10 |

2, Avid Maching Monito
% Avid Multicast Repea -Periodic Save
% fwid Service Starter
2. avid System Configu
2, Avid Tirne Synchroniz
» &, jkaspersp -Advanced settings
» 2 smaverdell
> & smayerp Lows memary threshold (%% ):
» & terhpubez00 15 20 25 30
» % techpubs-ie y ;
» B techpubss400 Critical mernory threshold (96

Period (rmin): |12IJ
Maximurn files: [10000

-Storage

!11 [ lij )] ] >

6. Click Join High Availability Group and type a name for the group.

Perform this step even if there is only one Media Indexer for shared storage. The Media
Indexer that monitors shared storage must be part of a High Availability group even if
there is only one Media Indexer in the group.

64



Installing Software on an Avid Interplay Media Indexer Server

Fil=  Action  Wisw Help i
iHDStS |SJ."‘?Pr0cesses| ’ Apply ” Apply To.. ” Reset ]

¥ DUCWG Avid Interplay Media Indexer ]

[S
& doctm ~High Availability
» & doctransfer
v & docw 4 Join High Availability Group
2 Group Name: [Unity |

R
% twid Machine Morito
2. avid Multicast Repea -Periodic Save
Q, Avid Service Starter
2, Avid Systern Configu
% twid Time Synchroniz
> & jkasperzp ~Advanced settings
» Q, smayerdel
» & smayerp Low memary threshaold (%)
» &, techpubszo0 15 20 2
» B techpubs-ie J
s Q, terhpubsa400 Critical mernory threshold (9% )

Weight in Group: |10

Period (rmind: |12D
Maxirnurn files: {10000

o -
[4x)
o

10 15 20

~Storage

7. Click the Apply button.
8. Click the Configure button.

The system opens the Configure Storage dialog box. The following illustration shows a
Media Indexer that is already configured to monitor folders on two workspaces.

Configure Storage on docwg, primary of group Unity % J

Add...

|__°| Wavid-6c85183bafyworkspace 1 avid rmediafiles [MNormal ]
] Wavid-6c85183baf warkspace2' avid mediafiles [Normal] Remave

Change...

Move Lp

Move Down

9. Click the Add button.
The Add Storage dialog box opens.
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@- Select the type of storage to add
_) Media Files Location

Avid Interplay Media Indesxer

[ (]9 | [ Cancel ]

10. Select the Media Files Location option and click OK.
The Media Files Location dialog box opens.

11. Type the UNC path to a folder within the workspace. For example,
\\computer_name\workspace_name\folder_name.

The following illustration shows the UNC path for the Avid MediaFiles folder on
workspace3. The system name in this example is avid-6¢85183baf.

Enter path to an essence folder to index.
||ua\rid—6|:85183baﬂwarkspac93‘;avid mediaﬁles|[ ]

[ Reset “ (0] 4 |[ Cancel ” Apply ]

In general, don’t connect directly to the high level workspace name. Connect to the Avid
MediaFiles folder or another folder in the workspace that you know contains valid Avid
media files. This way you will avoid attempting to index non-Avid files.

12. Click Apply and click OK.
The system displays the UNC path to the folder in the Configure Storages dialog box.

Dunﬁgure Storage on ducwg= Erimarx of group Unity E.
#®]vecia Tabie | add...
| viavid-5ce5183bafyworkspace 1iavid mediafiles [Mormal]
[ viavid-Bces183bafyworkspace2tavid mediafiles [Mormal] Remove

[ viavid-Bces183bafyworkspacedtavid mediafies [Mormal]
Change. ..

Mowve Lp

Mawe Do
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The message “Normal” indicates that the drive has been scanned and is currently
indexed. The message “Normal - Scanning” indicates the Media Indexer is now
scanning the storage area.

% On shared storage, the Media Indexer does not recognize drive letters mapped by the user
because it runs as a background service.
13. (Option) Click Add and repeat the process to add any additional folders.
14. Click Apply and click OK to close the Configure Storages dialog box.
The first time that you configure a storage folder, the Media Indexer automatically indexes

the media in the folder. This might take a while depending on the amount of media in the
folder.

For information on configuring the Media Indexer on an Avid editing application system to
communicate with this shared storage Media Indexer, see “Connecting the Media Indexer on
an Avid Editing System to the Media Indexer Monitoring Shared Storage” on page 80.

For more information, see “Different Types of Media Indexers” on page 37.

Tips for Adding a Shared Storage Workspace

If the Media Indexer Configure Storages dialog box shows Storage Not Found in the
pathname you type, verify that you are using the UNC pathname to a folder containing Avid
media files.
To check the name to use in the UNC path:

1. Open My Computer on the Media Indexer system.

2. Check the name of the computer and workspace in the display.

The following illustration shows the name for the computer and workspace names used
in this example.
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! My Computer

File Edit WYiew Favorites Tools Help
() Back ~ £3 ~ (T | ) Search [ Folders | & [ X ) | -
Address I j Tl Caniputer
Mame | Tvpe | Tokal Sizel
Hard Disk Drives
Local Disk. 63,4 5B
Devices with Removable Storage
< DYDCD-RAW Drive (E:) D Dirive
Network Drives
S#Det on 'avid-6c85183baf' (F1) Metwork Drive 50.0 GB
Workspace and— | Z# workspacel on 'avid-6c85183baf (G:) MNetwork, Drive 400 GE
computer name S Workspace? on avid-6c85183baf (H:) Metwiork Drive 400 =B
for workspacel S Workspaces on 'avid-6c85183baF (11 Metwork Drive 300 GE
<]

This example requires the following UNC path for the Avid MediaFiles folder on
Workspacel:

\avid-6¢85183baf\Workspace1\Avid MediaFiles

Installing Software on the CaptureManager Server

If this is the first time you are installing the CaptureManager software, you need to install
Microsoft SQL Server 2005 Standard before you install the CaptureManager software. For
installation procedures, see the Avid CaptureManager Installation and Configuration Guide
and the Avid CaptureManager ReadMe.
To install software on the CaptureManager server:
1. Click Servers on the Main Menu window, and then click CaptureManager Server.
The system launches the CaptureManager Server installation software.

2. Install CaptureManager software.

For information on installing and configuring CaptureManager, see the Avid
CaptureManager Installation and Configuration Guide.

3. (Option) Install the Interplay Transfer client software.
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Installing and Configuring Avid Interplay Low Res
Encoder Software

The software for updating the Avid Low Res Encoder is on the Interplay Installer DVD. The
following are in the Avid_Low_Res_Encoder folder at the top level of the DVD:

»  Files for updating the root disk image in the Avid_Low_Res_Encoder\rootdiscupdate
folder

*  One file for updating the bootset that begins with the characters avid.ipv.mxf.

To access the files:
1. Navigate to the DVD drive in the Windows Explorer.
2. Right-click the DVD name, and select Explore.

For information on updating the software on the Avid Low Res Encode system, see the
Avid Interplay Low Res Encode Setup and Configuration Guide. on the Avid Knowledge
Base.

Additional Information for Installing the Root Disk and Bootset

The Avid Interplay Low Res Encode Setup and Configuration Guide describes how to install
the root disk and bootset. Older versions of the document do not specify how to obtain the
files from the Avid Interplay Installer DVD.

The files are located in the Avid_Low_Res_Encode folder on the DVD. The following
limitations apply:

*  When updating the bootset, you can either browse to the Avid_Low_Res_Encoder
folder on the DVD or copy the file to a folder before you click the Browse button.

*  When updating the root disk image, you must copy the rootdiscupdate files to the local
path you create in the section “Setting Up the FTP Server” in the setup and
configuration guide. You can’t perform the root disk image update directly from
the DVD.
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Installing Software on Interplay Clients

The following topics describe the Interplay software installation on Interplay clients:

Installing Software on Avid Instinct and Avid Interplay Assist Systems
Installing Software on an Interplay Access System

Installing Software on Avid Editing Systems

Panasonic DVCPRO P2 and Ikegami NLTEK Media

Installing Software on a CaptureManager Client

Installing Software on a Pro Tools Interplay Client
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Installing Software on Avid Instinct and
Avid Interplay Assist Systems

Avid Instinct and the Avid Interplay Assist application require the same Interplay
components. You install the Avid Instinct and the Avid Interplay Assist applications from
the application DVDs. This section describes how to install the additional components
required by the Interplay environment.

& For Interplay v1.2.3, the Assist and Instinct installers do not automatically install the
Interplay Transfer Client components. You must install the components from the
Interplay Installer DVD. See “Assist and Instinct Installers Require Manual Install of
Transfer Client” on page 74.

To install software on Avid Instinct and Avid Interplay Assist systems:

1. Click Clients in the Main Menu window.

The Install Client Support window opens.

Items with three dots open a new window. Items without three dots start an installer.

2. Click either Avid Instinct Client or Avid Interplay Assist.

The corresponding client support window opens. The following illustration shows the
Install Avid Interplay Assist window.
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3. Install the following components on the client.

- Avid Interplay Framework for Client — The installer automatically installs the
components required for the application. When the system asks for a workgroup
name, type the name of the workgroup you set up on the Interplay Engine. The
name is case sensitive.

- Avid Interplay Access — Installs the Interplay Access and Interplay Administrator
applications.

- Avid Interplay Assist — Installs the Assist application software. You use the
Interplay Installer DVD to install the Instinct and Assist applications.

Avid Instinct and the Interplay Assist application must have either an Avid Unity
MediaNetwork Connection Manager or an Avid Unity ISIS Client Manager installed and
configured to connect to shared storage.

The Avid Instinct user must have a login to an iNEWS server.

For information on Avid Instinct and Avid Interplay Assist, see the Avid Instinct User’s
Guide and the Avid Interplay Assist User’s Guide.
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Assist and Instinct Installers Require Manual Install of Transfer Client

For Interplay v1.2.3, the Assist and Instinct installers do not automatically install the
Interplay Transfer Client components. You must install the components from the Interplay
Installer DVD as follows.

1. On the installer main page, click Clients. The Install Client Support page opens.
2. Click Avid Editor Support. The Install Avid Editor Support page opens.
3. Click Avid Interplay Transfer Client and follow the prompts.

Installing Software on an Interplay Access System

You can install Interplay Access on any system that you want to use to work with the
Avid Interplay Engine. Besides installing Avid Interplay Access, this installation also
installs the Avid Interplay Administrator.

To install software on an Interplay Access system:

1. Click Clients in the Main Menu window and then click Avid Interplay Access.

The Install Avid Interplay Access window opens.

2. Install the following components on the client.
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- Avid Interplay Framework for Client — the installer automatically installs the
components required for the application. When the system asks for a workgroup
name, type the name of the workgroup you set up on the Interplay Engine.

The Interplay Framework is optional for an Interplay Access system.

- Avid Interplay Access — this installs the Interplay Access and Interplay
Administrator applications.

For information on using the Avid Interplay Access and the Avid Interplay Administrator,
see the following manuals:

»  Avid Interplay Access User’s Guide
»  Avid Interplay Engine and Avid Archive Engine Administration Guide

Macintosh Installer for Interplay Access Client

Interplay Access is supported on Mac OS X. On the OS X platform, support is limited to

operations relating to file assets (not Avid sequences, clips, and so on). For more information

about using Access with Mac OS X, see the Avid Interplay Access User’s Guide.

The installer for Mac OS X is located on the Avid Interplay Installer DVD in the following

folder:
Installers\JXDK\Mac_Installer

To run the Macintosh® installer for Interplay Access:
1. Open the DVD on a Windows system.
2. Copy the installer.zip file to your Macintosh system.
3. Unzip the file and run the installer.
The installation software installs Interplay Access in the following folder:

Applications\Avid\Avid Interplay Access
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Installing Software on Avid Editing Systems

Use the Avid Editor window to install Interplay components on the following systems:

*  Avid NewsCutter Adrenaline and Avid NewsCutter XP

*  Avid Media Composer

e Avid Symphony Nitris

Each of these Avid editing applications has its own installation DVD for the Avid editing
application software. This section describes how to install the components that are required
by the Interplay environment.

To install Interplay components on an Avid editing system:

1. Click Clients in the Main Menu window and click Avid Editor Support.

The Install Avid Editor Support window opens.

2. Install the following components:

- Avid Interplay Framework for Client — the installer automatically installs the
components required for the application. When the system asks for a workgroup
name, type the name of the workgroup you set up on the Interplay Engine.
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If the editing system is on a different subnet from the system running the Interplay

Framework Lookup service, you must use Unicast Discovery to allow the editor to

locate the Lookup Server or install a MultiCast Repeater on at least one system on

that subnet. For more information, see “Connecting Systems Directly to the Lookup
Service” on page 116 and “Configuring a Multicast Repeater” on page 117.

- Avid Interplay Access — installs the Interplay Access and Interplay Administrator
applications.

- Avid Interplay Media Indexer — you configure this Media Indexer to communicate
with the Media Indexer monitoring shared storage. For more information, see
“Connecting the Media Indexer on an Avid Editing System to the Media Indexer
Monitoring Shared Storage” on page 80. You can also configure the Media Indexer
to index your local drives. For more information, see “Configuring the Local Media
Indexer to Index Local Drives” on page 84.

- (Option) Avid Interplay Transfer Client — install this software to take advantage of
Interplay Transfer features such as Send to Playback and workgroup to workgroup
transfers. For information on configuring the Interplay Transfer client, see the Help
for your Avid editing application or the Avid Interplay Transfer Setup and User’s
Guide.

- (Option) Avid Interplay ProEncode Client— install this software if you are using
ProEncode services with your Interplay Media Services server.

% The Avid editing applications must have either an Avid Unity MediaNetwork Connection
Manager or Avid Unity ISIS Client Manager installed and configured to connect to shared
storage.
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Configuring an Avid Editing System in the Interplay Framework

After you complete the installation on each Avid editing system, verify that the Interplay
Framework services are running on that system.
To verify that the Interplay Framework services are running:

1. Click the Start button, and then select All Programs > Avid > Interplay Framework >
Avid Interplay Workgroup Properties.

The Avid Interplay Workgroup Properties window opens.

% Avid Interplay Workgroup Properties A x|
| Services || Login | Lookup | Location | System Check | About |
workgroup:  [DOCWG |
Status: @ |AII enabled services are running. |
| [ Start ] [ Stop ] [ Advanced.,. ]
Check mark
[ Apply ][ Ik ][ Cancel ][ Help ]

2. If your Workgroup name doesn’t appear in the Workgroup field, click the Edit button
and type the name of the Workgroup.

% The Workgroup name can be different than the name of the computer that the Workgroup
database is running on. This depends on how your Workgroup was originally configured. In
this example, the Workgroup name is the same as the machine name.

If there is a green check mark next to the “Status” field, all services are running.
3. If the check mark is not green, click the Advanced button.
The Avid Interplay Services dialog box opens.
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Avid Interplay Services

] Marne | Description Start
@ '{) Avid Interplay Media Indesxer Indexes media to improve the performance

@& @ twid Machine Monitoring Service The Machine Monitoring Service monitors the
@ @ avid Service Starter Service Starts other Avid Interplay Framework Servig Enable
& © bwid Time Synchronization Service  Makes sure that all Interplay Framework Ser Refrash

Stop

el

< ) >

This dialog box allows you to view all services that are monitored by the Avid Interplay
Framework.

4. If necessary, select a service and click Start.

To verify that your system is listed in the Interplay Framework:

1. On any system that has the Avid Interplay Service Configuration tool installed, click the
Start button, and then select All Programs > Avid > Interplay Framework >
Avid Interplay Service Configuration.

The Avid Interplay Service Configuration window opens.
2. See if the system you want to verify is listed.

3. If the system is in the list, then it is part of the Interplay Framework. You can optionally
click the triangular opener next to the name and check which services are running on the
system.

4. If the system you want to verify is not listed, it might be on a different subnet than the
system running the Interplay Framework Lookup service. In that case, you need to use
Unicast Discovery to allow the editor to locate the Lookup Server or install a MultiCast
Repeater on at least one system on the other subnet. See “Connecting Systems Directly
to the Lookup Service” on page 116 and “Configuring a Multicast Repeater” on page
117.
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Connecting the Media Indexer on an Avid Editing System to the Media
Indexer Monitoring Shared Storage

An administrator can configure the Media Indexers for the Avid editing applications on any
system running the Interplay Service Configuration component of the Interplay Framework
software.

To configure the Media Indexer for an Avid editing application:

1. Click the Start button, and then select All Programs > Avid > Interplay Framework >
Avid Interplay Service Configuration.

2. If more than one workgroup appears in the list, click the triangular opener next to your
Workgroup name to open the Workgroup list.

3. Locate the Avid editing system in the list and select the Avid Interplay Media Indexer
service.

The following illustration shows an Avid editing system named techpub8200n.

-4 Avid Interplay Service Configuration

File  Action  Wiew  Help

gHDStS | @Processes ] Apply Reset

¥ @DDCWG Lvid Interplay Media Indexer |
[
&, doctranser High &valabiity

v & docwg
. Avid EMail Alert Service [ Jain High' &vailability Group
R avid Interplay Media Indexer Group Name: | |
2, awirl Machine Marnitor Service Weight in Group: |1 |
©. Awid Multicast Repeater
. fwid Service Starter Sarvice -Periodic Save

9; Avidd SHMP Gateway Service
% Avid Systern Configuration Sel
% twidd Time Synchronization Sel
» & smayerpc -Storages
» & smaverp
» &, techpubazo0
v & techpub8200n
1" il Interplay Media Indexer
9; Avidd Maching Monitor Setvice
% Avid Service Starter Service
% twidd Time Synchronization Sel
» R techpubs_ie

Period {min): |12D |
Maxirnurn files: {10000 |

The system prompts you for the Interplay Framework administrator password. By
default, there is no password.
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4. Click Yes, when the system displays a message asking if you want to allow the service
to run with unrestricted security.

5. Click Configure.
The Configure Storages dialog box opens.

W)i1edia Table

6. Click Add.
The Add Storage dialog box opens.

e
=L Media Files Location
! terp rdia In r

dlia Ir

iterpl

_'_
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7. Select Avid Interplay Media Indexer and click OK.
The Avid Interplay Media Indexer dialog box opens.

Avid Interplay Media Indezer E.

(_)[Connect to a specific Media Indexer|

Computer Marme: |d0cwg

[ Configure. .. ]

@ Connect to a High Availiabilty Media Indexer Group

Group Mame: |Unity E’]|

Mode: |LDad Balanced E]|

[ Reset “ (0] 4 |[ Cancel ” Apply J

8. Do the following:
a. Select Connect to a High Availability Media Indexer Group.

b. Select your group from the Group Name menu.
Ask the Interplay system administrator for the name of the High Availability Group.

c. Select Load Balanced from the Mode menu.
d. Click Apply, and then click OK.
The system displays the high availability group in the Configure Storages dialog box.
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Dunﬁgure Sturages on techEuhBZDDn E

) Media Table add. .
[ ) irity [Load Balanced, connected to docwg]

Remawe

Change. ..

Mowve Lp

Maowe Do

[ Reset ” Ik |[ Cancel ” Apply ]

If you click the triangular opener, the system displays the storage locations associated with
the Media Indexer on shared storage.

9. Click Apply, and then click OK to close the Configure Storages dialog box.

Using the Processes Tab to Configure Media Indexers

Rather than selecting systems individually on the Hosts tab, you can also select the
Processes tab on the Interplay Service Configuration window and configure the Media
Indexers for all the systems on the Interplay environment from that tab.

To use the Processes to configure the Media Indexers:

1. Click the Start button, and then select All Programs > Avid > Interplay Framework >
Avid Interplay Service Configuration.

2. Click the Processes tab and select the Avid Interplay Media Indexer service.
3. Select the Avid editing system.

4. Click Configure and connect the system to the High Availability Group as described in
“Connecting the Media Indexer on an Avid Editing System to the Media Indexer
Monitoring Shared Storage” on page 80.
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The following illustration shows the Processes tab with the Media Indexer for shared
storage selected.

.1 Avid Interplay Service Configuration :
File  Action  Wiew Help
| aHDsts | Q:;}Processes ‘ Apply Reset

¥ @DDCWG Lvid Interplay Media Indexer ]
> B avid EMail alert Ser.., High Awalebility

v 2 svid Interplay Media Indexer

2, techpubEzon I 10in High Availability Group
g techpub8200n Group Mame: |Unit3r |
Wieight in Group: |1E| |
2 smaverip
» 2 fvid Machine Monitor Service -Periodic Save
» % Avid Multicast Repea.., By (il |120 |

» % Avid Service Starter Ser..,
b & fvid SNMP Gateway Ser...
» B fvid System Configuration Ser... “Storages

b % Avid Time Synchronization Ser..,

Maxiraurm files: [10000 |

For more information on the Media Indexer, see Avid Interplay Framework User’s Guide
and the Avid Interplay Best Practices.

Configuring the Local Media Indexer to Index Local Drives

To configure the local Media Indexer to index your local drives:

1. Click the Start button, and then select All Programs > Avid > Interplay Framework >
Avid Interplay Service Configuration.

2. If more than one workgroup appears in the list, click the triangular opener next to your
Workgroup name to open the Workgroup list.

3. Locate the Avid editing system in the list and select the Avid Interplay Media Indexer
service.
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The following illustration shows an Avid editing system named techpub8200n.

< i Awid Interplay Service Configuration :
File  Action ‘iew Help

aHosts | S'-"‘?Processes | Apply Reset

¥ DDCWG &vid Interplay Media Indesxer ]
»
&, coctransfer ~High Avalability

v 2 docwg
g Avid EMail Alert Service [ Jain High' &vailability Group
% avid Interplay Media Indexer Group Mame: | |
2 swirl Maching Maritor Service Weight in Group: |1 |
2. Avid Multicast Repeater
% Avid Service Starter Service -Petiodic Save

% Avid SHMP Gateway Service
. wid System Configuration Se
2. Avid Time Synchronization Se
» &, smayerpc -Storages
» B cmayerp
» &, techpubsz00
v 2 techpubg200n
"M vid Int Indese
% Avid Machine Monitor Service
% Ayid Service Starter Service
2. Avid Time Synchronization Se
» 2. techpubs_ie

Period {min): |12D
Maximurn files: [10000

4. Click OK when the system prompts you for the Interplay Framework administrator
password. By default, there is no password.

5. Click Yes, in the a message box asking if you want to allow the service to run with
unrestricted security.

Allowr Unrestricted Security?

@- The service that you have selected needs additional security privieges beyvond those granted by default,
_.) wWiould you like to allow this service to run with Unrestricked Security?

=

6. Click Configure.

The Configure Storages dialog box opens. In the following illustration you can see that
this Media Indexer is already connected to the shared storage Media Indexer.
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') Meria Table
[® Uity [Load Balanced, connected to docwag]

7. Select the Media Table icon and click Add.
The Add Storage dialog box opens.

G
=F S\ Miedia Files Location
Avid Interplay Media Indesxer
P

8. Select Media Files Location and click OK.
The Media Files Location dialog box opens

Browse button.
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9. Click the Browse button.

% You can use the Browse button when you configure local storage but you must type a UNC
path when you configure shared storage drives.
The Open dialog box opens.
10. Navigate to the location of your Avid MediaFiles folder.

The following illustration shows the Avid MediaFiles folder on a MediaDock storage
device.

@ MediaDack (E:)

ElavidMedafles ]

All Files Lvl|

11. Click Open.

The Media Files Location dialog box opens and displays the new location.

E:\Avid MediaFies [

[l

| | | |

12. Click Apply and then click OK.
The Configure Storages dialog box opens and displays the new location.
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|

W edia Table
Local ) Unity [Load Balanced, conmnected to docwg]
storage [ yytechpubiS200m, avid mediafiles_6 [Mormal - E:\Avid MediaFiles ]

13. (Option) Click the Add button to add any additional storages.
14. Click Apply and then click OK to close the Configure Storages dialog box.
15. Click Apply in the Interplay Service Configuration window, and then close the window.

To instruct Media Indexer to automatically recognize local drives:
1. Start the Avid editing application.
2. Select Tools > Media Creation.

The Media Creation window opens.
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Panasonic DVCPRO P2 and lkegami NLTEK Media

3. On the Drive Filtering and Indexing tab, click the “Auto-index local drives as they come
online” button.

The local Media Indexer automatically configures Avid media files on your local drives.

If you don’t want the Media indexer to automatically scan your local drives, deselect the
Auto-index option.

4. (Option) Click Manual Storage Scan to start a scan.

5. (Option) Select one of the warning options. The warning occurs if the Media indexer has
problems scanning files on the local drive.

Panasonic DVCPRO P2 and lkegami NLTEK Media

Interplay supports Panasonic® DVCPRO® P2 equipment and Ikegami® NLTEK equipment.
For information on using the equipment in an Interplay environment, see the latest version of
the Interplay ReadMe on the Knowledge Base.
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Installing Software on a CaptureManager Client

To install software on the CaptureManager client:

1. Click Clients in the Main Menu window.

The Install Client Support window opens.

2. Click CaptureManager Client.

The system begins the installation.

For information on using the CaptureManager client, see the Avid CaptureManager User’s
Guide and “Configuring Avid AirSpeed in Avid Interplay Adapter” on page 126.
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Installing Software on a Pro Tools Interplay Client

The Pro Tools Interplay Client installers allows you to install Interplay Access and the

Pro Tools Interplay Option on a Pro Tools system (Windows only). The Pro Tools Interplay
Option allows you to use Interplay to pass audio files back and forth between Avid video
editing systems and Pro Tools® editing systems.

Pro Tools Interplay Option requires Pro Tools v7.3 or greater.

To install software on the Pro Tools client:

1. Click Clients in the Main Menu window.

The Install Client Support window opens.

2. Click Pro Tools Interplay Client.
The Install Avid Interplay Access window opens.
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3. Install the following components on the Pro Tools system (Windows only).

- Avid Interplay Access — This installs the Interplay Access and Interplay
Administrator applications.

- Pro Tools Interplay Option— This installs the following components into the
Interplay Administrator application: “Editor Export Settings for Pro Tools” and
“Pro Tools Import Settings.”

The next time you launch Pro Tools, the following menu options are available:
*  File > Import > Sequence from Avid Interplay
*  File > Export > Selected Tracks to Sequence in Avid Interplay

For information on using the Pro Tools Interplay Option, see Avid Interplay Best Practices.

% You can also install this option on another system in order to make it more convenient for the
Interplay administrator to configure the Import and Export settings.

Establishing the First Connection Between Pro Tools and Interplay
After you use the Interplay Installer DVD to install the Pro Tools Interplay Option and

Interplay Access on your Pro Tools system, you must use Interplay Access to establish a
connection to the Interplay database that you will be using. This is a one-time requirement
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that establishes the connection between your Pro Tools system and Interplay. Simply logging
on to the Interplay Engine database from Access will establish the connection. Then you can
exit Access and start using Pro Tools with Interplay.

In order to create this initial connection between Access and Interplay, there must be an
available license on the Interplay Engine. For example, if you have 10 Access licenses and
all 10 are being used, one person must log out of Access while you establish this initial
connection.

For information on licenses and for information on using Pro Tools in an Interplay
environment, see the Avid Interplay Best Practices guide.
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You can run individual optional installers as described in the following sections:

*  Performing a Custom Install of the Interplay Framework Software

» Installing Avid Interplay Access or Avid Interplay Media Services and Transfer Status
*  Browsing the Interplay Installer DVD

Performing a Custom Install of the Interplay
Framework Software

The Interplay Framework is used to monitor and configure the Media Indexer and the
optional Interplay Auto Archive service. It also lets you monitor the health of other
components that have the Interplay Framework installed and to view logs on the systems.
For more information, see the Avid Interplay Framework User’s Guide.

You install different components of the Interplay Framework software on different systems
in the Avid Interplay environment. The individual installation windows automatically install
all the components needed for the clients and servers. This installer lets you select and install
specific components.

For a list of the Framework components that should be installed on different systems, see
“Software Installed on Avid Interplay Systems” on page 30.

To install the Interplay Framework software:
1. Click Individual Optional Installers in the Main Menu window.

The Install Optional window opens.
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2. Click Avid Interplay Framework Custom.

The Introduction window opens.
3. Click Next.

The Choose Install Folder window opens.
4. Accept the default values and click Next.

The Join a Workgroup window opens.
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Performing a Custom Install of the Interplay Framework Software

i'—.{-" Avid Interplay Framework - Installshield Wizard

Workgroup Name

Join & Warkgroup

Twpe new or existing workgroup name in the space provided below, wWorkgroup
Mames may contain the letters A-Z, numbers 0-9, andjor dashes, If vou enter an
existing workgroup, you will have access to services already configured, IF wou
start a new warkgroup, vou will need ko propetly configure Framework on all
machines in the workgroup, This setting is case-sensitive,

IDDCWG|

Imstallshield

< Back I ek = I Zancel

5. Type the name of your Workgroup and click Next.

Use the same Workgroup name on all Interplay clients. You can either use the default
value or type a name for your Workgroup. The name is case sensitive.

If you are updating the Interplay Framework software, the installer remembers the
last installed value. If the workgroup name was changed after the install, the installer
will not be aware of the change.

The Options window opens.
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{& Avid Interplay Framework 1.1.0.101 - InstallShield Wizard x|

Options

Select From one of the Following kypical install options. You will be able to refine
wour seleckion later if needed.

& pwid Interplay Framework Client
Al Framework Applications

€ all Framewark Services and Applications

" Typical Avid Interplay Server Install

Imstallshield

< Back. I Mext = I Zancel |

6. Select the type of Framework installation you wish to make. For more information, see
“Interplay Framework Components” on page 31.

7. Click Next.

The Custom Setup dialog box opens. This dialog box displays the components that will
be installed.

The following illustration shows the default components for a Framework Client install.
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i'é'n Avid Interplay Framework - InstallShield Wizard |

Custom Setup ‘

Select the program Features you want installed. "
prog v &

Click. on an icon in the list below to change how a Feature is installed,

= Feature Descripbion

--------- (= ~ | Diagnoskic Log Viewer Installs a remate configuration
......... 3¢ ~| Email Alerter kool which can be used to
_________ "=~ | Health viewer configure other discoverable

: SErvices,
......... ¥ | Lookup Service

......... - M h Monikar S i
= a;:_ ne Mankar BWICE. This feature requires 7736KE on

--------- X | Multicast Repeater Service wour hard drive.

--------- ¥ | SNMP Gateway Service

--------- ¥ | System Configuration Service

--------- (= ~ | Time Zynchronization Service

Install ko

C:\Program Files)AvidiInterplay Framewaork), e —— |
Imstallshield
Help | Space | < Back I Mext = I Cancel |

If this is not the correct set of components, do one of the following:
P Click the Back button and select a different group.

P Select or deselect components from the list in the Custom Setup dialog box.
Don’t add components that you don’t need. This can affect system performance.
8. Click Next and follow the installation instructions to complete the installation.

The installer might require that you restart your system to complete the installation.

Verifying that the Interplay Framework Services Are Running

You must perform these steps on each system running the Interplay Framework Services.

To verify that the Interplay Framework Services are running:

1. Click the Start button, and then select All Programs > Avid > Interplay Framework >
Avid Interplay Workgroup Properties.

The Avid Interplay Workgroup Properties window opens.
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% Avid Interplay Workgroup Properties m
[ Services || Login | Lookup | Location | System Check | about |

workgroup:  [DOCWG || Edit... ]

Status: & [AII enabled services are running.

[ Start J [ Stop J [ Advanced.,.

—

If there is a green check mark next to the “Status” field, all services are running.
2. To view the services, click the Advanced button.

The Avid Interplay Services dialog box opens.

Avid Interglav Services

o Marne | Description Start
@ | @ avid Interplay Auto Archive and Aut,,. Support Auta Archive and Auto Transcocs
@ @ awid Machine Monitoring Service The Machine Monitoring Service monitors t Stop
& @ 2vid Service Starter Service Starts other Avid Interplay Framework Ser Enable

@ @ avid Time Synchronization Service Makes sure that all Interplay Framework Se Refrech

el

This dialog box lets you view all services that are monitored by the Interplay
Framework.

3. If necessary, select a service and click Start.
Disabling Framework Services
Depending on the system you install the Interplay Framework Services on, you might need
to disable some services. You might also want to disable some services to conserve memory

usage. For more information, see “Software Installed on Avid Interplay Systems” on page
30.
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To disable a service:

1. Click the Start button, and then select All Programs > Avid > Interplay Framework >
Avid Interplay Workgroup Properties.

The Avid Interplay Workgroup Properties window opens.
2. Click the Advanced button.
The Avid Interplay Services dialog box opens.

Avid Interplay Services '
] Mame | Description | | start |

& | & avid Interplay Auto Archive and Aut..., Support Auto Archive and Auto Transcodd ————————
& '."} Avid Maching Monitoring Service The Machine Monitoring Service monitors t |5ti|
& & »avid Service Starter Service Starts other Avid Interplay Framework Ser | Enatile |

& @ avid Time Synchronization Service Makes sure that all Interplay Framework Se
Refresh

| 1} ) ]l

. Select the service you want to disable and click Stop.
. After the service stops, click the Disable button to disable the service.

. Click Exit to close the Avid Interplay Services dialog box.

AN n B~ W

. Click OK to close the Avid Interplay Workgroup Properties window.

Installing Avid Interplay Access or Avid Interplay
Media Services and Transfer Status

You can install Interplay Access or Interplay Media Services and Transfer Status
applications on any qualified Windows XP system running in your Interplay environment.
This lets you run the applications without affecting the work on other systems such as a
server or an Avid editing system.

To install the Avid Interplay Access or Avid Interplay Media Services and Transfer
Status software:

1. Click Individual Optional Installers in the Main Menu window.

The Install Optional window opens.
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2. Install either of the following components:

- Interplay Access —Installs the Interplay Access and Interplay Administrator
applications. For more information, see “Installing Software on an Interplay Access
System” on page 74.

- Interplay Media Services and Transfer Status service — This lets you view the
status of Interplay Transfer and Interplay Media Services jobs. For information on
configuring the Interplay Media Services and Transfer Status application, see the
Avid Interplay Transfer Setup and User’s Guide.

3. Follow the onscreen instructions to complete the installation.

Browsing the Interplay Installer DVD

To browse the DVD:
1. Click Individual Optional Installers in the Main Menu window.
The Install Optional window opens.
2. Select “Browse all installers.”

3. (Option) Select any of the installers from the Installers folder, and perform a
custom installation.
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Engine

For more details on the Archive Engine, see Avid Interplay Best Practices and the Avid
Interplay Media Services Setup and User’s Guide.

The following topic is covered in this chapter:

» Installing the Archive Engine Software

*  Setting Up a Failover System

»  Updating the Archive Engine Software

Installing the Archive Engine Software

You need to install the following software on the Archive Engine server:
* Interplay Archive Engine

* Interplay Access

»  FlashNet Client software

To install the Interplay Engine software:

1. Insert the Interplay Installer DVD into the DVD drive on the Interplay Archive Engine
system.

2. Click Servers in the Main Menu window.

The Install Servers window opens.
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3. Click Avid Interplay Archive Engine.

4. Install the Interplay Archive Engine and Interplay Access on the system.

Additionally, you must install the Interplay Archive Provider on a separate server.

To install the Interplay Archive Provider software:
1. Click Servers in the Main Menu window.
The Install Servers window opens.
2. Click Avid Interplay Media Services.

3. Click Avid Interplay Archive to install the Archive Provider. For information on setting
up the Interplay Archive provider and Interplay Auto Archive, see the Avid Interplay
Media Services Setup and User’s Guide and the Avid Interplay Access User’s Guide.

Installing the Interplay Access Software

The Archive Engine maintains a database that can be accessed through Interplay Access. For
information on configuring the server, see the Avid Interplay Engine and Avid Archive
Engine Administration Guide.

For information on using Interplay Access on an Archive database, see the Avid Interplay
Access User’s Guide and the Avid Interplay Media Services Setup and User’s Guide. For
information on archiving from within the Avid editing application, see Avid Interplay Media
Services Setup and User’s Guide.
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Installing the FlashNet Client Software

Typically your Software Generation Limited (SGL) representative installs and configures
the FlashNet client software when he or she configures the rest of the archiving system. For
information on using the FlashNet client, see the documentation provided by your SGL
representative.

Installing the Interplay Archive Provider Software

%

You typically install the Interplay Archive Provider software on a separate server for
performance reasons. Install the Interplay Archive Provider from the Avid Interplay Media
Services page of the Interplay Installer. See “Installing Software on the Media Services
Server and Media Services Provider Servers” on page 58.

The Interplay Archive Provider requires an Avid Interplay Media Services application key
(also referred to as a dongle) with the Archive and Restore option.

Setting Up a Failover System

You can configure the Avid Interplay Archive Engine in a cluster configuration for
automatic failover protection. For details on setting up the system, see the Avid Interplay
Engine Failover Guide on the Knowledge Base.

Updating the Archive Engine Software

When you update the Archive Engine, do not delete the software using the Add/Remove
Programs or any other mechanism for deleting software. If you delete the software, the
system deletes the folder structure in place at the time of the update. To update the software,
insert the Interplay Installer DVD and follow the installation instructions. The system
updates the software without performing a remove operation. This preserves the folder
structure.
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I Additional Configuration Topics

This chapter covers the following topics:

Using Time Synchronization in an Avid Interplay Environment

Setting the Automatic Restart Feature in the Avid Interplay Framework
Installing the Lookup Service on a Separate Server

Connecting Systems Directly to the Lookup Service

Configuring a Multicast Repeater

Configuring Avid AirSpeed in Avid Interplay Adapter
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Using Time Synchronization in an Avid Interplay
Environment

108

The Avid Time Synchronization Service enables time synchronization between different
machines in a workgroup. The Time Synchronization Service can operate in either Master
mode or Slave mode. In Master mode, the service retrieves a reference time from a
configured time source and redistributes it to the Slave services within the workgroup. The
time source can be the local PC clock, an NTP server, or an Adrienne timecode card
installed in the server. If multiple Time Synchronization Services are configured as Master,
they coordinate among themselves and identify one Primary service to distribute the time
notifications (the others are in Backup mode and silent until a Primary fails, at which time
one of the Backups takes over). In Slave mode, the Time Synchronization Service listens for
time notifications from the workgroup and (optionally) sets the local PC clock to match.

Slave Time Sync services are only useful to set the local PC clock. If you aren’t using your
slave Time Sinc to set the local PC clock, you can disable the Time Sync service on
that computer.

The following are the three typical ways of implementing Time Synchronization in an
Interplay environment:

* In Interplay environments that use CaptureManager to capture material, a
CaptureManager system is usually designated as the Time Sync master. The
CaptureManager system has an Adrienne card. Install the Interplay Framework Time
Synchronization service on the CaptureManager system and configure it as a Time Sync
master.

¢ Ifyou don’t use a CaptureManager system, do one of the following:

- Designate another system with an Adrienne card as the Time Sync master. Install
the Interplay Framework Time Synchronization service on this system and
configure it as a Time Sync master.

- Use an NTP server for Time Sync reference. Install the Interplay Framework Time
Synchronization service on a system on the network that does not need to be shut
down frequently and configure the service as a master. When you configure the
master, point to the NTP service for time sync.

- Designate any system that rarely has to be shut down as the Time Sync master and
set the Time sync reference to the internal PC clock on that system.

It is important to use only one time synchronism mechanism to set the local PC clocks in the
Interplay environment. If a Time Synchronization Slave service is configured to set the local
PC clock and it detects that some other mechanism (such as Windows 32 Time Services)
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changes the local clock, the Time Sync Slave service disables itself to avoid the local clock
from jumping back and forth. The Time Sync slave also posts a Warning in the Health
Monitor.

When you install the Time Synchronization service on a system it runs as a Time Sync slave
by default. For information on how to configure a Time Sync master, see “Configuring the
Time Sync Master” on page 109.

Time Sync and Log Files

All “Framework enabled” services that produce log files listen to the timestamps sent out by
a Time Sync Master. They do this to produce a “Sync Time” field in the log files. So, even if
the local PC clocks on all the computers do not match, the “Sync Time” field in the log files
is always in sync across all the log files on all the machines.

Configuring the Time Sync Master

To configure the Time Sync Master:

1. Install the following Interplay Framework components on the system that will be used
as the master:

- Core Components

- Configuration Utility

- Diagnostic Log Viewer
- Health Viewer

- Machine Monitor

- Time Synchronization

2. On any system that has the Interplay Configuration Utility installed, click the Start
button and select All Programs > Avid > Interplay Framework > Avid Interplay Service
Configuration.

The Interplay Service Configuration window opens.

3. Select the system that will be the Time Sync master and click Avid Time
Synchronization.

The Time Synchronization Settings window opens.
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-4 Avid Interplay Service Configuration

File Action \iew Help

&Hnsts |5"i}l3r0cesses ’ Apply ” Reset ]

¥ @DDCWG Time Synchronization Settings |
b E. doc2pe
» %- doctm @ Master Mode (distributes timestamps ta the rest of the workagroup)
b E. doctransfer ] )
¥ % docwg Tirme Stamp Interval (in seconds) |1D
&, fwid EMall Alert Servi @(Get Time Sync reference from the local PC dack]

E. Avid Maching Monitor

% vid Medialndaser (O Get Time Sync reference from an MTP Server

2. swid Multicast Repeal NTP Server Mame ‘

E. Avid Service Starter ¢
Q. Avidd SMMP Gateway (0 Get Time Sync reference from an internal TimeCode Reader
E. Avid Systern Configus
Q, Avid Time FOriiz () Slave Mode (receives timestamps from other Masters in the workgroup)
2 smayerpc
E. ssaveall2
L techpub8200 [ set the local PC clock to match the "wWorkgroup” time

E. techpubs200n

yF-v¥yrw-

4. Select options as described in the following table.

Time Synchronization Settings

Options Description

Time Stamp Interval (in Determines how often the master sends out time stamp information. The
seconds) default is 10 seconds.

Get Time Sync reference  Select if you are simply using the local PC clock of one system on your
from the local PC clock network for time sync reference.

Get Time Sync Reference Select when you are pointing to an NTP server on your network for time
from an NTP server sync reference.

The NTP server does not need Interplay Framework software
installed on it.

Get Time Sync reference  Select when the Time Sync master system has an Adrienne timecode
from an internal Time card.

Code Reader CaptureManager systems have an Adrienne card.
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Setting the Automatic Restart Feature in the Avid
Interplay Framework

This procedure ensures that the Avid Service Starter Service automatically restarts other
services, such as the Interplay Media Indexer service, that need to be restarted. You must do
the following after you complete the upgrade installation:

1. Use the Interplay Service Configuration tool to set the Automatic restart option in the
Avid Service Starter service on all Framework client systems. You can use the Apply To
button to apply the setting to all systems.

2. Restart the Avid Service Starter service on each system running the Interplay

Framework. You must do this manually at each system.

The Apply To button does not allow you to automatically set Media Indexer settings on other
systems on the network.
To set the Automatic Restart option on all Framework clients:

1. Start the Avid Interplay Service Configuration tool.

2. Select any system in the Interplay environment and click the Avid Service Starter

Service as shown in the following illustration.

Server Starter service Select these
options

4 Avid Interplay Service Configuration

File Action Wiew Help

Ho_scion /
&Husts |5"5}Prc:cesses l Apply ” ABE"{TD--- H/RESEt ]

v @DDCWG Service Stapter Options |
» 2 doctm
" i’ doctranster Autormatically start opher 2vid Controlled services
¥ Q. docwqg
2. 2vid Interplay Medig Tndeser (2 Only start congrollied services once (at startup)

2. 2vid Lookup Servide
2. 2vid Machine Mdnitor Service

@ [Start contralled services any time they stop running unexpectadly|

%, Awid Multicast/Repeater I start confrolled services after a time delay

" Wil Service Starter |

— 10 Seconds
Q. Avid Systern Configuration Service

. swid Time Synchronization Service

3. Select “Automatically start other Avid Controlled services.”

4. Click “Start controlled services anytime they stop running.”
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112

5. Click Apply To.
The Apply To dialog box opens.

ﬂﬂEW To... E.

aHusts | @Prncesses l_

v DDCWG
v 2 avid Service Starter Ser

% doctrm
% doctransfer
2 docwg
% jkasperxp
% smayerdel
2 smaverp

CooOoOoO

[1[ li} J >
[ Select Al “ Clear Al J

[ ok |[ Cancel J

6. Click Select All and then click OK.

The system applies the setting to the Service Starter services on all of the selected
systems.

7. Restart the Service Starter Service on every system as described in the following
procedure.
To restart the Service Starter Service on all systems running the Interplay Framework:
1. Start the Avid Interplay Workgroup Properties tool.

The Avid Interplay Workgroup Properties window opens as shown in the
following illustration.
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% Avid Interplay Workgroup Properties m
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2. Click the Advanced button.

The Avid Interplay Services window opens.
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@ @ Avid Systern Configurati... An Avid Interplay Framework Service for storing shared
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@& @ twid Time Synchronizati... Makes sure that all Interplay Framework Services and
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3. Select Avid Service Starter Service and click Restart.
4. Click Exit and then click OK.

5. Perform the same procedure on all of the other systems running the Framework. This
must be performed manually for each system.

Installing the Lookup Service on a Separate Server

If you have more than 10 clients in your Avid Interplay Framework environment (including
Avid editing applications, Avid Instinct, and Avid Assist), Avid strongly recommends that
you put the Interplay Framework Lookup Service on a separate server such as a General
Purpose Server. For redundancy, you may decide to set up two separate servers running the
Lookup Service.

For specifications for General Purpose Servers see “Interplay Server System
Configurations” on page 139.
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To install the Lookup Service on a separate server:

1. Insert the Interplay Installer DVD on the General Purpose Server and start the Avid
Installer application.

2. Navigate to the Individual Optional Installers page. and Double click Avid Interplay
Framework Custom.

3. Follow the onscreen instructions and watch for the following items:
a. Enter your Workgroup name in the Workgroup Name window.

b. In the Options window, select “Typical Avid Interplay Server Install”.

Configuring Lookup Servers
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After you complete the installation, use the Avid Interplay Service Configuration tool to
check that the Lookup Service is not running on other Interplay Servers, particularly on

Media Indexer servers.You can use the Avid Interplay Framework Workgroup Properties
tool to disable the service on other servers.

For best results, connect each system running the Interplay Framework to the Lookup
Service manually via the Interplay Workgroup Properties tool. This technique is called
Unicast Discovery and is described in “Connecting Systems Directly to the Lookup Service”
on page 116 . Unicast Discovery avoids the need for configuring Multicast Repeaters
between different subnets and ensures a direct connection to the Lookup Service.

Technically there is no need for Unicast Discovery on a local subnet that contains a Lookup
Service. Unicast Discovery ensures connection to the Lookup Service but takes extra time to
configure on a large workgroup since you have to make the connection manually on each
system.

When working with multiple subnets you either have to use a Multicast Repeater or use
Unicast Discovery on the remote subnets. Unicast Discovery can be more reliable than using
a MultiCast Repeater because you are not relying on a single point of communication
between the subnets. Unicast Discovery also allows quicker registration and discovery
operations for systems on remote subnets.

If you use more than one Lookup Services, use Unicast Discovery to connect to both Lookup
Services on each machine.

Interplay System Configuration Service

Use the Interplay Service Configuration tool to check for occurrences of the System
Configuration Service on any of your Interplay servers. This service should only run on the
systems that contain the Lookup Service. Use the Interplay Workgroup Properties tool to
disable the service on any other servers.
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Installing the Lookup Service on a Separate Server

The System Configuration service is different from the Service Configuration tool. The
Service Configuration service runs the Interplay Service Configuration tool and can be
installed on any system running the Interplay Framework.

Configuring Lookup Servers on Avid Unity ISIS

You can single connect or dual connect the LUS using the following guidelines:

Single connect a LUS to each VLAN. In this case, use Unicast Discovery as follows:

- On each LUS system, open the Workgroup Properties tool, click the Lookup tab,
and enter the fully qualified domain name of the other LUS system.

- On each client, open the Workgroup Properties tool and specify the fully qualified
domain name of both LUS systems.

Dual connect the LUS server, connecting one NIC to each VLAN (subnet). For
redundancy, set up two LUS systems and dual connect both of them.

- Ifthe LUS is dual connected to both VLANS, you don’t need a Multicast Repeater
or Unicast Discovery for Zone 1 or Zone 2. In this case you do need to use Multicast
Repeater or Unicast Discovery for Zone 3 clients.

- When configuring the dual connection, both network interfaces on the LUS server
need to be registered in DNS with the exact same name. In other words, if you use
the nslookup command to look at the hostname of the LUS server, it should show
two IP addresses.

Even with dual connected LUS, the Interplay router needs to have a route configured
between the two VLANS.

There is no load balancing between Lookup Services. If you have two LUS systems they
operate independently of each other. All Framework services register with both services. To
ensure connectivity between subnets, you must either need use Multicast Repeaters or use
Unicast Discovery to connect all of your clients to both LUS.
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Connecting Systems Directly to the Lookup
Service

For systems on remote subnets, rather than working with Multicast Repeaters, it might be
more convenient to connect directly to the Lookup service using a technique known as
Unicast Discovery. You can also use this technique when you have problems configuring a
Multicast repeater and need to quickly connect systems to the Interplay Framework.

The main drawback to using the Unicast Discovery connection method is that if there are
multiple systems running the lookup service, you should connect to each one. This can take
a lot of configuration time in a large installation. If you don’t connect to all of the Lookup
service systems, if the one you are connected to goes down you lose your connection to the
interplay Framework.

To directly connect a system to a Lookup service:

1. Determine the fully qualified domain name of the system running the Lookup service.
For example, the following defines the domain name of the server named DocWG:

docwg.global.avidww.com

2. On the system on the remote subnet, click the Start button, and then select All Programs
> Avid > Interplay Framework > Avid Interplay Workgroup Properties.

3. Click the Lookup tab.
4. Select the Workgroup that you want to connect to and click Add in the Lookup services

window.

If the name of the workgroup that you need does not appear in the Workgroup area, click the
Add button and add the entry. Remember that the name is case sensitive.

5. In the Lookup services area, type in the fully qualified domain name of the system
running the Lookup service.

6. Leave the port value at the default 4160.

7. Click Expected and click OK.

8. The domain name appears in the Lookup services area, as shown in the
following example.
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Services | Login | Lockup | Location | Systemn Check | about |

Workgroup Lookup services

DocWiG

docwg.global. ay

[ Add “ Rermoye i [ Add H Edit ” Rermove ]

[ Apply ” (04 ” Cancel ” Help i

% In this example, the name of the workgroup is the same as the name of the machine running
the Lookup service.

9. Click Apply and click OK.

The system now appears in the Avid Interplay Service Configuration tool.

Configuring a Multicast Repeater

If your workgroup environment includes multiple subnets, you must install and configure
Multicast Repeater software on each subnet as part of the Interplay Framework installation
and configuration. For information on installing the Multicast repeater service, see
“Software Installed on Avid Interplay Systems” on page 30.

If you are troubleshooting a system that does not connect to the Interplay Framework, you
might find it faster to connect directly to the Lookup service using a technique known as
Unicast Discovery. See “Connecting Systems Directly to the Lookup Service” on page 116.

If a system on your workgroup is on a different subnet, it does not appear in the Interplay
Service Configuration window (or Health Viewer) until you configure a Multicast Repeater
for that subnet. See “Determining If You Need to Configure a Multicast Repeater” on page
119.
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If you already know that your system is on a different subnet, proceed to “Configuring a
Multicast Repeater” on page 122.

Understanding Multicast Repeaters

The Multicast Repeater is required when a workgroup must span multiple multicast
domains. In this case, each domain must have at least one Multicast Repeater service
running. Each of the machines running this service must identify other hosts running
Multicast Repeaters on other multicast domains. You use the Avid Interplay Workgroup
Properties tool to identify the Lookup services on the different multicast domains.

You can install more than one Multicast Repeater for redundancy. If multiple Multicast
Repeaters are in the same multicast domain, they defer responsibility to one another so that
only one is active at a time. When a Multicast Repeater receives a message tunneled to it
from another Multicast Repeater, it multicasts the message again in its own multicast
domain.

A multicast domain boundary usually occurs when you have machines running in different
subnets. However, routers can be configured to pass multicasts to other subnets, so a subnet
is not always the boundary of a multicast domain.

Example of Configuring Multicast Repeaters
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Assume that your workgroup is primarily in multicast domain #1 and you want to add a
machine from multicast domain #2 to the workgroup. In this case, install a Multicast
Repeater and a Lookup service on a server in multicast domain #2. The machine running
Multicast Repeater and Lookup Service should be one that rarely requires a restart because
stopping the Multicast Repeater causes communications disruption between the multicast
domains.

Installing the Lookup Service in multicast domain #2 ensures that a Lookup Service is
available in case of a network outage that prevents communications between the two
multicast domains.

A single Multicast Repeater is not useful by itself. It needs to have a counterpart in the other
multicast domain so they can tunnel to each other. The two Multicast Repeaters use the
Unicast Lookup Locators configured on the Lookup tab of the Avid Interplay Workgroup
Properties window to determine what hosts other Multicast Repeaters are running on in
other multicast domains.
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Determining If You Need to Configure a Multicast Repeater

If a system is not recognized by the Interplay Framework, the reason might be that the
system is on a different subnet. In this case you can either configure a multicast repeater for
each subnet as described in this section or you can use Unicast Discovery to communicate

between the subnets. See “Connecting Systems Directly to the Lookup Service” on page
116.

Checking Whether the System is Recognized by the Interplay Framework

To check if a system is recognized by the Interplay Framework:

P Click the Start button, and then select All Programs > Avid > Interplay Framework >
Avid Interplay Service Configuration.

The Avid Interplay Service Configuration window opens.

-+ Avid Interplay Service Configuration

File Action ‘Wiew Help

QHDsts |$Pr0cesses [ Ay H Reset l

v [alocwe
B doczpe
System running full set of —a#— ¥ 2. Docwi
Interplay Framework B avid EMail alert Service
services and the primary 2. 2vid Machine Monitor Service
Media Indexer for shared E- i Medialndaser
storage Q. Avid Service Starter Service
Q. Avidd SNMP Gateway Service
% Avid Systern Confiquration Service

2. 2vid Time Synchronization Service
» B pubscyope
> % sMayersp
Avid editing system with—a— ¥ &, techpubg200
local Media Indexer 2. 2vid Machine Monitor Service
Q. Avid Medialndesxer
. avid Service Starter Service

If a system on your workgroup does not appear on the list, it might be on a
different subnet.

Determining if a System is on a Different Subnet

This section describes how to determine whether a system in the Workgroup is on a different
subnet from the system running the Interplay Framework Lookup service.
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To check if a system is on a different subnet:

1. From a system that appears in the Interplay Framework, open the Avid Interplay Service
Configuration window and click the blue Workgroup icon that identifies the workgroup.

Click blue Workgroup icon
to open the Discovery
Manager window

. t doc2pe
v & DocwiG

2. 2vid EMal Alert Service

2. 2vid Machine Monitor Service

2. Avid Medialndexer

t Avid Service Starter Service

t Avidd SNMP Gateway Service

2. 2vid System Configuration Service
2. 2vid Time Synchronization Service

The Discovery Manager window opens.

The system running the Lookup service

o' [ DocwG.global avidwsy . corm: 4160 baS4ffd2-9329-456b-8a5a- 112ee6e964d0  DocWG

The Discovery Manager window identifies the system running the Lookup service.

If a system is on a different subnet without a Lookup service, no systems are listed and the
blue icon next to the workgroup name contains a red X indicating that no Lookup Service
can be found.
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2. Run the ipconfig command on the system running the Lookup service and on the system
that is not appearing in the Interplay Framework list by doing the following:

a. On each system, click the Start button, and then select All Programs >
Accessories > Command Prompt.

A Command prompt window opens.
b. Type ipconfig and press Enter.

The system displays information about the IP configuration.

Third octet of the IP address

Microzoft Windows HP [Uersion 5.1.260801
CC» Copyright 1985-2881 Microsoft Corp.

C:xDocuments and SettingssjeditorXipconfig

Windows IP Configuration

Ethernet adapter Local Area Connection:

Connection—specific DNS Suffix global.avidww.com
IP Addres=s. . . . . . . . . . . 172.28.12 123
Subnet Mask . - . . . . . . . . 2505 .255.254.8
Default Gateway . . . . . . - . 172.28.12 .1

C:“Documents and Settings“jeditor>

3. Check the third set of numbers (called the third octet) of the IP address. In this example,
the third octet value is 12.

4. Compare the ipconfig results on both systems. If the third octets of the IP addresses are
different, the systems might be on different subnets.

% This example assumes that the subnet boundary is based on the third octet. Depending on
the subnet mask, the subnet could also be based on one of the other octets. In some cases the
octet can actually be within a range of numbers and still be on the same subnet. You can use
an IP subnet calculation tool to determine whether the system is on a different subnet.

If the systems are on different subnets, configure a Multicast Repeater to communicate
across the subnets.
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Configuring a Multicast Repeater

In this example, assume that you have your main workgroup on multicast domain #1 and
you need to configure a Multicast Repeater on multicast domain #2.
To configure a Multicast Repeater:
1. Install the Multicast Repeater and Lookup Service on a server in multicast domain #2.
% The machine running Multicast Repeater and Lookup Service should be one that rarely

requires a restart because stopping the Multicast Repeater causes communications
disruption between the multicast domains.

2. On the server in multicast domain #2, click the Start button, and then select
All Programs > Avid > Interplay Framework > Avid Interplay Workgroup Properties.

3. Click the Lookup tab.

Services I Login || Lookup || Location | System check | about |
W orkgroup Lookup services

Expected| Hast |_Port |

[ Ald ” Remove ] Add [ Edit ” Remove ]

[ Apply ” (04 ” Cancel ” Help i

4. In the Workgroup column, click the Add button and add the Workgroup name.
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Select a
workgroup.

Add button in
the Lookup
Services
column

6. Type the fully qualified domain name of the system in the other multicast domain
(multicast domain #1 in this example) that is running a Lookup service. Keep the default
port number of 4160.
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x.

gavegsvr 1.global. avidvewr. com]| |

The Expected button does not have any effect at this time. It is intended for a future release.

7. Click OK.
8. Click Apply in the Avid Interplay Workgroup Properties dialog box.

Lookup
locator

You have now added a Lookup Locator to your system.

9. Perform steps 5 through 8 to add Lookup locators for any other Lookup services or
Multicast Repeaters in the workgroup.

You don’'t have to add an entry for the Lookup service running on the local machine.
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10. After adding the last Lookup locator, click the Apply button.

The system prompts you to restart the services.
11. Click Yes.

The system restarts the services on your machine to make the Lookup Locator active.
To configure the Lookup service on the main workgroup subnet to recognize the new
subnet:

1. On the system on multicast domain #1 running the Lookup service, click the Start
button, and then select All Programs > Avid > Interplay Framework > Avid Interplay
Workgroup Properties.

2. Click the Lookup tab.
3. Perform the same procedure to add a Lookup locator that identifies the Lookup service
on multicast domain #2.

The system on multicast domain #1 must also have a Multicast Repeater.

Once you complete this procedure, the Lookup services on each multicast domain is
able to use the Multicast Repeaters to communicate across subnets.
To remove a Lookup Locator:
1. Stop all the Interplay Framework services on the machine.
2. Remove the Lookup Locator from the Lookup tab.
3. Click the Apply button and then click Yes to restart the Interplay Framework services.
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Configuring Avid AirSpeed in Avid Interplay
Adapter

This section describes the settings that are specific to configuring an Airspeed in an
Interplay environment. For details on setting up and using AirSpeed systems, see the
following documents on the Knowledge base:
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Avid AirSpeed ReadMe

Avid AirSpeed Installation and User’s Guide

Avid AirSpeed I/O Applications User’s Guide

Avid AirSpeed Version 2.x Supported Configurations

For information on user names and passwords required for AirSpeed, see “User Names and
Passwords Required For Avid Unity and Product Servers” on page 25.

The following illustration shows important settings in an Interplay environment.

CAFTURE | [ SETUF ) | DIAGHOSTICS SHUTDOHH ﬂlﬂ‘d

Name of the system running
the Interplay Adapter.

For Avid Unity MediaNetwork,
name of the Portserver. For
B Pl (1216 ‘Avid Unity ISIS, name of the
BYW Mgmt 1515 System Director
Shared Storac TR0 .

2 Must be MXF in an Interplay

Current MetaData Frt environment

If the Current MetaData Fmt setting is not MXF, the AirSpeed is not communicating with
the Interplay Engine. Usually the problem is a network issue. Check the spelling of the Asset
Manager server name and verify the IP address on the Network tab. If you need to change
the values, restart the AirSpeed after you make the changes.



Configuring Avid AirSpeed in Avid Interplay Adapter

Interplay Adapter and AirSpeed

The Interplay Adapter (also referred to as the MMAdapter) is used by AirSpeed capture
systems to connect to the Interplay Engine. In general, one Interplay Adapter can service up
to 10 AirSpeeds. Interplay Adapter is also used by CaptureManager to checkin clips to the
Interplay database and by some third party applications for checkin and search functions.

Where you install the Interplay Adapter depends on how heavily you use your AirSpeed
systems. If you perform many AirSpeed captures, you might want to install the Interplay
Adapter on a CaptureManager server or on a dedicated server.

The following table lists the recommended systems for an Interplay Adapter installation.

Installation Locations for an Interplay Adapter

Server

Description

CaptureManager If you use CaptureManager to control your AirSpeed systems, this is the preferred

location for an Interplay Adapter.

General Purpose Server or A dedicated server is the best location if you perform a lot of AirSpeed captures.
another available server®  The Interplay Adapter can also run on a server that is not carrying a heavy load.

For example, if you have server dedicated to monitoring Interplay Transfers
(Interplay Transfer Cache Engine), you can install the Interplay Adapter on that

server.
Interplay Engine Only install Interplay Adapter on an Interplay Engine if you have up to a maximum
(non-cluster only) of 10 clients in your Interplay environment (clients include Avid editing systems,

Avid Assist, and Avid Instinct). If you find that system performance degrades when
you perform a lot of AirSpeed captures, then move the Interplay Adapter to a
different server.

a. Do not install the Interplay Adapter on a Media Indexer server or on an Interplay Engine cluster.

If you don’t have a CaptureManager system and you have a small number of AirSpeed
systems, you can put the Interplay Adapter on the same General Purpose Server as the
Lookup Service. If you observe performance issues when you perform many AirSpeed
captures, move the Interplay Adapter to another server.

For information on installing the Interplay Adapter and configuring it to recognize the
Interplay Engine, see “Installing Avid Interplay Adapter” on page 55.
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Configuring Interplay Adapter, CaptureManager, and AirSpeed
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A CaptureManager service named “Media Browse Unity Video Service” uses the Interplay
Adapter to check assets into the Interplay database. Prior to CaptureManager v4.0.4, you
could only have one Media Browse™ Unity Video Service running in a particular Interplay
environment.

Starting at CaptureManager v4.0.4, you can install a Media Browse Unity Video Service for
each Interplay Adapter in your Interplay environment. Now if one CaptureManager server
stops working, other CaptureManager servers can continue to check files into the Interplay
database.

For additional information, see the CaptureManager v4.0.5 ReadMe.

You can now configure single or multiple Media Browse Unity Video Services to check in
assets to the same Interplay Engine via distributed Interplay Adapters. For every Interplay

Adapter installed, a Media Browse Unity Video Service might also be deployed that points
at that Interplay Adapter.

For information on installing the Interplay Adapter and configuring it to recognize the
Interplay Engine, see “Installing Avid Interplay Adapter” on page 55.

When you install more than one Media Browse Unity Video Service, the following
configurations must be completed:

* Ifan Interplay Adapter is installed and running on a computer other than the Interplay
Engine computer, the mmserver.ini (located, for example, in C:\Program
Files\Avid\Avid Interplay Adapter\jakarta-tomcat\omm\RAM) must be edited to point
to the Interplay Engine by adjusting this value: “env.ABServer=". For more information,
see “Installing Avid Interplay Adapter” on page 55.

»  Each AirSpeed that will use a particular Interplay Adapter to check in assets must have
its Asset Manager value (in the Setup view) configured to point to the location of the
Interplay Adapter.

The following illustration shows the Setup view. In this example the Interplay Adapter is
running on the CaptureManager server named warm-capman.
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Server running the Interplay Adapter

) T DIAGHSTICS | (7 SHUTDOMA | A“{d
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E gt 1515
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Current WMetaData Frot

All CaptureManager channels with an AirSpeed device must have the Media Manager
Host Name for the AirSpeed device configured to be the same as the Asset Manager for
the AirSpeed.

The following illustration shows the settings in the CaptureManager Device Information
dialog box. In this example, the Interplay Adapter is running on the same system as the
CaptureManager so the MediaManager Host Name is the name of the local computer.
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Server running the Interplay Adapter AirSpeed device for this channel

I Avid AirSpeed

AirSpeed Hozt Mame or [P Addr

Iwarrm-airspeed-E

IEhanneI 1

AirSpeed Channel Mame:

Media Manager Host Mame: Iwarrm-capman

Timecode Source: IINTEHN.-’-‘-.L vI
Murnber of Audio Tracks to Record: |4 vI

Bole: {~ Source {+ Destination

Floute: I £nones j

(] 4 I Cancel

When you install CaptureManager, the installer asks for an Interplay Server as part of the
Media Browse Unity Video Service configuration.

The following illustration shows the dialog box.

Media Browsze Unity Yideo Service Config.: Dialog 1

What iz the 21D INTERFLAY SERVER with which thiz Unity Yideo Service will interact’y
[This hame iz required to be network rezalvable. |

Type the name of the system running the Interplay Adapter. You can also adjust the value in
the registry at the following location:
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[HKEY_LOCAL_MACHINE\SOFTWARE\INEWS\Media Browse\Media Browse Unity
Video Service]

n_nn

"Media Manager Host Name
If the Interplay Adapter is installed on the same computer as the Media Browse Unity Video
Service, all of the following settings use the same computer name:

*  Asset Manager value in the AirSpeed Setup view.

*  Media Manager Host Name setting in the AirSpeed device configuration in
CaptureManager channel.

* Interplay Server (Media Manager Host Name) for the Media Browse Unity Video
Service.

This is the case with the illustrations in this section. The Interplay Adapter is running on
the CaptureManager server named warm-capman.

Updating Software on an AirSpeed

You can use the Software tab on Airspeed to update software from an .ISO image on a web
server on the network. This section describes a method that uses the Apache® web server
running on the Avid Interplay Engine.

Read the latest AirSpeed ReadMe before installing the AirSpeed software.

To update AirSpeed software in an Interplay Environment:

1. Before you begin, obtain the .ISO image for the AirSpeed software update as described
in the Avid AirSpeed Installation and User’s Guide. Make sure that the name follows the
naming conventions in the AirSpeed guide.

2. Navigate to the Apache\root folder on the Avid Interplay Engine.

3. The following table shows the location on non-cluster and cluster systems.

Non-cluster system C:\Program Files\Avid Interplay Engine\data\Apache\root

The path to the Avid Interplay Engine folder might be different
depending on your installation.

Cluster system S:\Workgroup_Data\Apache\root
You must be on the active node to see the S: drive.

4. Create an iso folder in the Apache\root folder. This is a convenience; you can use any
name for the folder.

5. Copy the .ISO image to the Apache\root\iso folder.
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6. Start AirSpeed.
7. Click the Setup button and click the Software tab.

SYSTEH DESTIHATION

HETHOEK COHFIG CHAHHELS TEHFLATE

Server text box

ref M ch stats

8. Type the following in the Server text box:
Interplay_Engine/iso

where Interplay_Engine is the name of the system running the Interplay Engine. for
example, DocWG/iso. (Note the forward slash.)

9. Press Return.

The system displays the .ISO image in the Available Versions window.

% The system automatically locates the iso folder because it is located at the root directory of
the Apache web server running on the Interplay Engine.

10. Select the .ISO image and click Update Version.

11. Follow the onscreen instructions. See the Avid AirSpeed Installation and User’s Guide
and the AirSpeed ReadMe for any additional information.
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ﬂ SR2400 and SR2500 Slot Locations

The Intel® SR2400 and Intel SR2500 are supported servers for the Interplay applications.
This section shows the front and back views of the two servers and describes the slot
locations that are specific to the Interplay components.

e SR2400 and SR2500 Front View
e SR2400 Slot Locations
« SR2500 Slot Locations



A SR2400 and SR2500 Slot Locations

SR2400 and SR2500 Front View

The front view of the two servers is identical. The following illustration shows the front view
and control panel.

SR2400 and SR2500 Front View

DVD/CD-ROM
RAID disk (ID 1) ol = =
System disk (ID 0) E Control panel
o

The following table describes the control panel shown in the previous figure.

System Director Control Panel

Letter Description Letter Description

A Power/Sleep button G System ID LED (blue, a second system
ID LED is on the rear)

B NIC 2 activity LED H System ID button (System ID LED
blinks when pressed)

C NIC 1 activity LED 1 System reset button

D Power/Sleep LED J USB 2.0 connector

E System status LED K Recessed NMI button (need tool)

F Internal drive activity LED L Video connector
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SR2400 Slot Locations

The SR2400 can be configured to function in various ways within your Avid environment.
For details, see the following documents on the Avid Knowledge Base:

*  For Avid Unity MediaNetwork, see the Avid SR2400 Platform Introduction.
*  For Avid Unity ISIS, see the Avid Unity ISIS Setup Guide.

*  For cluster configurations, see the Avid Interplay Engine Failover Guide.

Use the following figure and table as guides to how your SR2400 is configured in an
Interplay environment.

SR2400 Back Panel

Small form factor slots not used\ PCI slots Power supplies
oooooooooooo o
cageascaooas | | > |lslot3 :
© |g2525858258s | S
ooooooOoooooo | | ° |50t2 0
oooooooooooo (o}
Mouse TST© 8888 oo | || o |[Slot1 a
o
oo(ER/o====ooooooe e0OOO |,
© (W W oo u A
Keyboard Video 1 2 ScsiB
RJ45t0 1 Gig u|s|B Primary power
serial B Enet  serial A to FIC switch if needed supply on bottom

% On the SR2400, all boards must be installed starting in the Top slot, and the second board
must be in the middle slots, it cannot be in the bottom slot with the middle slot left open.
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SR2400 Back Panel Configuration Options for Avid Unity MediaNetwork

Interplay Engine |nterplay Engine Interplay Transfer,
and other? Cluster and Archive Archive Providers, and
Slot PortServer (Pro) Interplay servers Engine Cluster ProEncode
3 ATTO™ ATTO ATTO ATTO
2 Alacritech® Empty QLogic® Card PRO/1000 MT/MF/XF®
Ethernet® board
1 Empty Empty PRO/1000 MT Emulex® 1050 ¢

Includes servers for Interplay Archive Engine, Interplay Media Indexer, Interplay Media Services, and
Transcode Providers

b. Install PRO/1000 MF or XF as optical options for use with Interplay Transfer/AirSPACE™.
. Install Emulex 1050 for use with Interplay Transfer/Profile.
. All boards must be installed starting in the top slot (3) and the second board must be in the middle slot (2); do not

install a board in the bottom slot (1) with the middle slot left open. If there is no PRO/1000 board, the Emulex 1050
must be installed in the middle slot (2).

SR2400 Back Panel Configuration Options for Avid Unity ISIS

Interplay Transfer,

Interplay Engine and Interplay Engine Cluster and Archive Providers, and

Slot other? Interplay servers Archive Engine Cluster ProEncode
3 Empty IPRO/1000 MT PRO/1000 MT/XF/MF®
2 Empty QLogic card Emulex 1050¢ ¢
1 Empty Empty Empty

a. Includes servers for Interplay Archive Engine, Interplay Media Indexer, Interplay Media Services, and

Transcode Providers

b. Install PRO/1000 MF or XF as optical options for use with Interplay Transfer/AirSPACE.

c. Install Emulex 1050 for use with Interplay Transfer/Profile.

d. All boards must be installed starting in the top slot (3) and the second board must be in the middle slot (2), do not

install a board in the bottom slot (1) with the middle slot left open. If there is no PRO/1000 board, the Emulex 1050
must be in the top slot (3).

If you need to move ATTO boards, PRO/1000 XF boards, or Emulex 1050 boards from an
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SR2500 Slot Locations

The SR2500 is supported as a server for the Interplay applications. This section describes
the slot locations that are specific to the Interplay components.

SR2500 Slot Locations

Use the following figure and tables as guides to how your SR2500 is configured in an
Interplay environment.

SR2500 Back Panel

PCle slots PCI-X slots Power supplies
o P
0ooooooooooo [Slot3 | o |slot3 o
( |pooooooooooo o
goEoEooooons G %
doooooooooog |Slot2 o |[Slot2 o
Mouse _|  |oooooooooooo g
S '@ 253585 oo |[Slot 1 || o |[Slot1 E
&) Lil . Iil‘:‘o S#%/0 E=F= poooooo[oooo| [ggloooo®
Kevboard \/ Video 1 2
eyboar .
RJ45t0 1Gig US|B Primary power
serial B Enet supply on bottom

%

Serial A to F/C switch if needed

Its important to match the slot locations in the following tables because they match the order
that the drivers are loaded on the SR2500 Recovery DVDs.

SR2500 Back Panel Configuration Options for Avid Unity MediaNetwork

Interplay Engine
and other?

Interplay Engine
Cluster and Archive

Interplay Transfer,
Archive Providers, and

Slot Type Slot Interplay servers Engine Cluster ProEncode
PCI-X 3 ATTO ATTO ATTO

2 Empty Empty Emulex 1050°

1 Empty QLogic Card PRO/1000 MF/XF¢
PCle 3 Empty Empty Empty

2 Empty PRO/1000 PT PRO/1000 PT¢

1 Empty Empty Empty

a. Includes servers for Interplay Archive Engine, Interplay Media Indexer, Interplay Media Services,
Transcode Providers, and General Purpose Server.

b. Install Emulex 1050 for use with Interplay Transfer/Profile.
Install PRO/1000 MF or XF as optical options for use with Interplay Transfer/AirSPACE.

e

d. Optional replacement for Intel PRO/1000 MF or XF.
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SR2500 Back Panel Configuration Options for Avid Unity ISIS

Interplay Engine and Interplay Transfer,
other? Interplay Interplay Engine Cluster and Archive Providers,
Slot Type Slot servers Archive Engine Cluster and ProEncode
PCI-X 3 Empty Empty PRO/1000 XF/MEF®
2 Empty Empty Emulex 1050°
1 Empty QLogic Card Empty
PCle 3 Empty Empty Empty
2 Empty PRO/1000 PT PRO/1000 PT¢
Empty Empty Empty
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Transcode Providers, and General Purpose Server.

Install PRO/1000 MF or XF as optical options for use with Interplay Transfer/AirSPACE.

Install Emulex 1050 for use with Interplay Transfer/Profile.

Optional replacement for Intel PRO/1000 MF or XF.



E Interplay Server System Configurations

The following table lists the basic system configurations for Avid Interplay servers.

Avid linterplay Server System Configuration

System

Interplay Engine
Interplay Archive Engine
General Purpose Server

Interplay Engine
Interplay Archive Engine
General Purpose Server

Base
System

Base
System

Platform

Intel SR2400
Dual Xeon® 3.2GHz CPUs
2x300 GB drives mirrored

Intel SR2500

Dual Xeon 5130 dual core,
2.0GHz

2x500 GB drives mirrored

Intel SR2400
Dual Xeon 3.2GHz CPUs
2x300 GB drives mirrored

Intel SR2500

Dual Xeon 5130 dual core,
2.0GHz

2x500 GB drives mirrored

System
Operating System Memory
English 4GB
Windows 2003 Server
SP2
English 4GB
Windows 2003 Server
SP2
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Avid linterplay Server System Configuration (Continued)

System
System Platform Operating System Memory
Clustered Two clustered Intel SR2400 English 4GB
System Dual Xeon 3.2GHz CPUs Windows 2003 Server

2x73 GB drives mirrored SP2 using

RAID enclosure: g/([)l(;:;OEOft Wl,n dows

One Infortrend® A16F-R2221 s nlterf“,se

RAID disk array enclosure with erver clustering

6x250 GB drives

Same RAID enclosure for SR2400

and SR2500

Two clustered SR2500

Dual Xeon 5130 dual core,

2.0GHz

2x250 GB drives mirrored
Interplay Transfer Intel SR2400 English Windows XP 2 GB

Dual XEON 3.2GHz CPUs Pro

1x73 GB drive

Intel SR2500

Dual Xeon 5130 dual core,

2.0GHz

1x250 GB drive
Interplay Media Services Intel SR2400 English Windows XP 2 GB
Engines? Dual Xeon 3.2GHz CPUs Pro

IX73GB drive Microsoft SQL Server

2005 Express on the

Intel SR2500 Media Services server

Dual Xeon 5130 dual core,

2.0GHz

1x250 GB drive
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System

Interplay Transcode
Provider

Interplay Archive Provider
Interplay ProEncode
Provider

CaptureManager Server

Platform

Intel SR2400
Dual Xeon 3.2GHz CPUs
1x73GB drives

Intel SR2500

Dual Xeon 5130 dual core,
2.0GHz

1x250 GB drive

Intel SR2400
Dual XEON 3.2GHz CPUs
4x73GB drives

Intel SR2500
Xeon 5130 dual core, 2.0GHz
2x500 GB drives mirrored

a. The Media Services Engine can be co-located with a single provider.

System
Operating System Memory

English Windows XP 2 GB
Pro

Windows 2003 Server 2 GB
SP2

Microsoft SQL Server
2005 Standard Edition

4GB
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Interplay Maintenance
Recommendations

This chapter provides a list of maintenance activities that should be performed regularly in
an Interplay environment.

* Interplay Daily Maintenance Check List
* Interplay Weekly Maintenance Check List
* Interplay Monthly Maintenance Check List
*  Avid Unity ISIS Recommended Maintenance
- Avid Unity ISIS Daily Maintenance
- Avid Unity ISIS Weekly Maintenance
- Avid Unity ISIS Monthly Maintenance
- Available Avid Unity ISIS Administration Utilities

- Complete Server Room Shutdown



C Interplay Maintenance Recommendations

Interplay Daily Maintenance Check List

Interplay Daily Maintenance Check List

Task For more information

Avid Unity ISIS

a See “Avid Unity ISIS Daily Maintenance” on page 149.

Avid Unity MediaNetwork

a Check the Active File Manager “Monitor Tool” for errors. Avid Unity MediaNetwork
Administration Guide

a Verify that the Standby File Manager is “Started”, and in
“Standby” mode.

a Check available “Free Space” on Unity workspaces.

AirSpeed Playout Servers

a Check Dashboard for “Warnings” or “Alerts.” Avid AirSpeed Installation and
User’s Guide

FlightPlan for Countdown™

a Check the internal drives on the Playback AirSpeeds for clips that have Avid AirSpeed ReadMe,
not been trasnferred. Special Notes section

Avid Interplay Media Indexer

a Use the Avid Interplay Framework Health Monitor to check memory  Avid Interplay Best Practices
and CPU usage. If the available memory falls below 10% (red zone in
Health Monitor), the Media Indexer stops indexing new files.

a Check the Health Monitor to make sure the number of “Table adapter
listeners” is consistent with the number of actual clients connected to
the MI. This number should be close to the actual number of machines
connected to the MI. If this number keeps growing and becomes greater
than the number of clients by an order of magnitude, call Avid
Technical Support and schedule a restart for the MI.

Avid Editing Applications

a Restart all Avid editing client systems including Media Composer,
NewsCutter, NewsCutter XP, Symphony, Avid Assist, and Avid Instinct.

a Restart all Avid Adrenaline and Avid Nitris media I/O peripherals.
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Interplay Weekly Maintenance Check List

Interplay Weekly Maintenance Check List

Interplay Weekly Maintenance Check List

Task

For more information

Avid Unity ISIS
a See “Avid Unity ISIS Weekly Maintenance” on page 150
Interplay Engine and Interplay Archive Engine

a Ensure that individual ingest folders do not contain more than 20K objects
each.

a Delete older AvDeletes log files from the following folder:

*  \\InterplayEngineName\C$\Program Files\Avid\Avid Interplay
Engine\Logs\Machines\InterplayEngineName

Interplay Transfer Server

a Restart the Interplay Transfer Engine application.

Interplay Media Services

a Purge all jobs and restart the Media Services server and Provider systems,
including Transcode Provider, Archive Provider, and ProEncode Provider.
To purge jobs, use the Avid Interplay Media Services and Transfer Status
window.

% Do not shut down the Media Services server while jobs are in
progress. It is fine to shut down the server while jobs are pending.
They will restart after the server is restarted.

Avid Media Indexer

a Rebalance the Media Indexer configuration and/or storages to make sure
sufficient indexing memory is available for the Media Indexer.

Use the Avid Interplay Service Configuration tool to check and modify the
Media Indexer configuration.

a If the file count is growing close to the maximum number of files for all
Media Indexers, prepare to configure a new Media Indexer.

See the Ingest and Capture
Limitations section in the
Avid Interplay ReadMe

Avid Interplay Transfer
Setup and User’s Guide

Avid Interplay Media
Services Setup and User’s
Guide

Avid Interplay Software
Installation and
Configuration Guide

Avid Interplay ReadMe
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Interplay Weekly Maintenance Check List (Continued)

Task

For more information

Avid Interplay Low Res Encoder

a Restart the Avid Interplay Low Res Encoder systems.

Use the Web interface to reboot the Low Res Encoder. This ensures
that you don’t interrupt any ongoing recordings.

Avid Interplay Adapter

a Restart Avid Interplay Adapter applications.

Avid Low Res Encode
Setup and Configuration
Guide

See “Installing Avid
Interplay Adapter” on
page 55 and “Configuring
Avid AirSpeed in Avid
Interplay Adapter” on
page 126.
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Interplay Monthly Maintenance Check List

Interplay Monthly Maintenance Check List

Interlay Monthly Maintenance Check List

Task

For more information

Avid Unity ISIS

a See “Avid Unity ISIS Monthly Maintenance” on page 151

Avid Unity MediaNetwork

a Shut down all Unity MediaNetwork systems using the following shutdown  Avid Interplay Software
order: Installation and

1.

e e A o

—
[\ e )

13

Avid editing applications Configuration Guide

AirSpeeds

CaptureManager

Interplay Transfer

Avid Interplay Media Services and Providers

Interplay Engine and Avid Interplay Archive Engine

Media Indexers (don’t stop Media Indexer while it is indexing storage)
Systems running Interplay Framework Multicast Repeaters

Systems running the Interplay Framework Lookup Service

. PortServer

. Invoke Fail-Over on Unity File Managers

. Standby File Manager: stop the File Manager, then shutdown
. Active File Manager: stop the File Manager, then shutdown

a Restart all Unity MediaNetwork systems using the following restart order:

1. Primary File Manager (wait until server is fully up and running)
2. Standby File Manager
3. PortServer
4. System running the Avid Interplay Framework Lookup Service
5. Systems running Interplay Framework Multicast Repeaters
6. Media Indexers
7. Restart the remainder of the systems in any order.
a Verify that all clients have mounted the necessary Unity workspaces.
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Interlay Monthly Maintenance Check List (Continued)

Task For more information

Interplay Transfer Server

a Delete the following Interplay Transfer temp files from the C: drive: Avid Interplay Transfer

* My Computer>Local Disk C:\temp Setup and User’s Guide

* My Computer>Local Disk C:\tmp

a Delete the following Interplay Transfer server log files from the C: drive:

My Computer>Local Disk C:\Program Files\Avid\TransferManager
Server\tmserverlog

a Reboot Interplay Transfer server CPUs. Stop the Interplay Transfer Engine
application and then reboot the CPU.

a Restart Interplay Transfer Engine application from the desktop shortcut.

Avid Interplay Framework

a Use the Health Monitor to check memory and CPU usage of server-side Avid Interplay Framework
Framework services (Lookup, System Configuration, Time Sync Master, User’s Guide
Email, SNMP). Check to make sure that none have memory that is
increasing at an unusual rate and that none have persistently high CPU
usage.
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Avid Unity ISIS Recommended Maintenance

Avid Unity ISIS Recommended Maintenance

The following maintenance recommendations are not meant to be a troubleshooting guide
but more of a care and monitoring check list for Avid Unity ISIS. Typically, the Avid Unity
ISIS does not need to be power cycled. All components of the Avid Unity ISIS stack can be
individually replaced or restarted without interfering with the production of Avid Unity ISIS
stack.

& Power cycling the entire stack (all the components at the same time) could risk the
stability of the Avid Unity ISIS stack.

For information on using the tools described in this section, see the Avid Unity ISIS
Administration Guide.

Avid Unity ISIS Daily Maintenance

The following contains a list of items you should do on a daily basis. It is estimated to take
15 minutes to perform these functions.

*  Check the Storage Elements status: Open the Administration tool and click Storage
Elements.

- You should see a green circle beside the storage blade in the Name column
- Check the Status column for errors or Network Degraded

The Status column in the Storage Elements report the status of the storage element
logged by the System Director. (The Status line in the Details area reports the same
information.) When the storage element maintains a working status, the
Administrator tool displays no entries in the Status field. If a problem arises, or
when the status of the storage element changes, the Administrator tool updates the
Storage Elements dialog box.

*  Check the Storage Blade Status and Switch Blade Status: Open the Administration tool
and click Chassis.

- You should see a green circle beside each chassis in the Serial Number column

- Check the both Status columns for errors
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When the chassis, switches and storage elements maintain a working status, the
Administration tool displays no entries in the status field. If a problem arises, or
when the status changes, the Administration tool updates the status column and the
Details area.

Start the Monitor Tool and check the front (ISBs) and back (ISSs, ISXs, and power
supplies) for errors.

You can hover your mouse pointer over a component and status details are displayed.
Errors display as red or yellow components, or as a warning icon on the component.

Check System Director Control Panel on the Active System Director for errors. On the
System Director Status tab, make sure there are no red indicators in the status box.

- Check for green indicators beside the “System Director is running” and “Both paths
are up”

- Check that a blue or green indicator is displayed beside “Replicated” on the Active
System Directory

- If'the event log indicator is not green, check the Windows Event logs on the Active
System Director

Check System Director Control Panel on the Standby System Director for errors.

- Verify the Standby System Director is “Started” and in “Standby” Mode. Check for
green indicators beside the “System Director is running” and “Both paths are up”

- Check that a blue or green indicator is displayed beside “Receiving”

- Ifthe event log indicator is not green, check the Windows Event logs on the Standby
System Director

Check that the Avid Unity Workspaces have “Free Space” available: Open the
Administration tool and click Workspaces.

Avid Unity ISIS Weekly Maintenance

The following contains a list of items you should do on a weekly basis. It is estimated to take
30 minutes to perform these functions.

Review Windows Event logs on the Active and Standby System Directors

Check the ISB network connections between the ISBs using the ISB Connection
Analyzer. All Storage Elements should be green.

In the Avid Unity ISIS Switch Blade Agent, run the Switch Infrastructure Diagnostics
located in the Advanced tab. Select all tests, both the left and right networks, and all
chassis.

% Do not run the switch diagnostics during heavy usage or critical network production times.
Some tests burden the system’s bandwidth and resources.
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In the results page, save the diagnostic results by clicking the Download link and save the
file using the date as part of the file name.

Check the RAID status on the System Director using the CIM Browser utility icon on
the right-side of the taskbar. The CIM Browser icon must be green (looks like a square).
You can hover your mouse pointer over the icon to see the utility name, double-click the
icon to start the utility.

Make sure you have at least one storage element worth of free space (500 GB or 1 TB,
depending on the size of your storage blades) for each storage group. If a storage blade
should fail, you need enough space to remove the failed storage blade.

Avid Unity ISIS Monthly Maintenance

You should test a failover on a monthly basis. It is estimated to take 1 hour to perform this
function.

Take a snapshot — The ISIS Snapshot tool collects information currently displayed by
the Administration tool and the Avid Unity ISIS System Director Control Panel. Open
the Administration tool and click the System tab. Select ISIS Snapshot > Create new
snapshot.

Perform System Director Primary to Secondary Failover — Turn off one of the System
Directors and verify in the System Director Control Panel that the Active Mode
indicator has turned red. Turn the System Director back on and see that Active Mode
displays Standby.

Check the Redistribution status: Open the Administration tool and click Workspaces.

- The Redistribution column for each workspace should be blank, and have less than
10 configuration changes (see Config Changes column)

- Ifyou have 10 or more configuration changes, the status is highlighted in yellow
and displays “Requires Full Redistribution” in the Redistribution column

You should do a full redistribution at the next maintenance interval. Schedule a time
when the system is not heavily used, as this will allow the full redistribution to
complete in the shortest amount of time.
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Available Avid Unity ISIS Administration Utilities

The following is a list of headings in the Avid Unity Administration Guide that describe other
utilities and tools for monitoring and troubleshooting.

*  Avid Unity ISIS System Director Control Panel
e System Administration Tools
- Changing the Administration Password
- Setting up Error Notification
- Avid Unity ISIS Snapshot Tool
- Using the Profile Tool
*  System Statistics
*  System Logging
- Accessing the Logging Window
- Viewing Event Logs
*  Avid Unity ISIS Log Aggregator Too
*  Avid Unity ISIS Disk Tester Tool
*  Avid Unity ISB Connection Analyzer Tool
*  Avid Unity ISIS Switch Manager Tool
*  Avid Unity ISIS Agents
- Agent Tools
- Log Viewer Tool
- Switch Infrastructure Diagnostics
*  Avid Unity ISIS System Monitor Tool

*  System Director event message meanings
Client Manager Maintenance

If you suspect a poor connection between your client system and a mounted workspace, you
can test the Avid Unity ISIS media network connection between each client system and the
media network using the Avid PathDiag tool. This tool informs you if there is sufficient
read/write throughput for read and write operations needed by the client system. For more
information on using the Avid PathDiag tool see, Avid Unity Client Manger Guide. This
guide also describes the following Administrative tasks:

*  Clearing Cached Data
* Using Logs and Messages

152



Avid Unity ISIS Recommended Maintenance

Status Indicators and Troubleshooting

If the LEDs on the ISSs or ISBs are indicating a problem, identify the problem using the
information under, “Status LEDs and Stacking Problems” in the Avid Unity ISIS Setup
Guide.

Complete Server Room Shutdown

%

There is no requirement to power cycle the entire Avid infrastructure but, if the need arises
to turn off all the equipment (such as a relocating the server room), turn off the components
in the following order. When turning on the components, use the reverse order.

To shut down the entire Avid Interplay workgroup (server room):

1.

[ee]

Shut down all Avid editing system and attached media I/O equipment, for example Avid
Mojo and Avid Adrenaline hardware.

. Shut down all capture and playout servers such as AirSpeeds.

. Shut down CaptureManager Server.

Shut down Interplay Transfer Server.

. Shut down Avid Interplay Media Services and Providers
. Shut down Interplay Engine and Avid Interplay Archive Engine.

. Shut down Media Indexers — Don’t stop Media Indexer while it is indexing storage.

See “Shutting Down a Media Indexer System” on page 39.

. Shut down Systems running Interplay Framework Multicast Repeaters.
. Shut down Systems running the Interplay Framework Lookup Service.
10.
11.
12.
13.

Shut down Backup Avid Unity ISIS System Director.
Shut down Primary Avid Unity ISIS System Director.
Shut down Avid Unity ISIS Drive Chassis.

Shut down Foundry Switches.

Turn on the entire rack of equipment in reverse order as above and verify that all clients
have mounted the necessary Avid Unity ISIS Workspaces.
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2] Avid Interplay Port Usage

The following table lists networks ports used by Interplay. It does not include ports used by
shared storage (Avid Unity ISIS, MediaNetwork or Lanshare). This information is useful to
network administrators when configuring the network and firewalls, setting up ISIS Zone 3
clients, and resolving network conflicts.

Avid Interplay Port Usage

Component and Location Port Protocol Purpose
Access 8321 UDP Server Browser.
80 TCP Server communication.

Access can also be a Media Indexer client
(update media status, Resync), Media Services
client (status tool plugin and submit jobs to
archive and Transcode), and Transfer Engine
client (status tool plugin, initiate WG2WG
transfers); see appropriate sections.

Active Directory 135 TCP RPC for Active Directory / Windows Domain
Authentication.
Archive Provider 1433 TCP #Microsoft-SQL-Server (ms-sql-s).
1433 UDP #Microsoft-SQL-Server (ms-sql-s).
1434 TCP #Microsoft-SQL-Monitor (ms-sql-m).
1434 UDP #Microsoft-SQL-Monitor (ms-sql-m).
8192 TCP #FlashNetBackupClient (sdss).
Assist Assist uses Access ports for Interplay engine

communication. It is also a Media Indexer client.
See appropriate sections for port usage.

Cluster Service 135 TCP RP; also used by Distributed Link Tracking
Server - Service Name TrkSvr and Distributed
Transaction Coordinator - Service Name
MSDTC).



D Avid Interplay Port Usage

Avid Interplay Port Usage

Component and Location

DNS

iNews

156

Port

Random

3343
53
21

22
25
67
80
513
600
698

699

1019
1020

1022

1023

Protocol

TCP

UDP
UDP/TCP
FTP

SSH

Purpose

Randomly allocated high TCP ports; also used
by Distributed Link Tracking Server - Service
Name TrkSvr and Distributed Transaction
Coordinator - Service Name MSDTC).

Cluster Services (service name: ClusSvc).
DNS Client.

FTP into iINEWS database: Teleprompters,
NewsCutter newsroom system tool, Data
Receiver.

ssh.

sendmail.

Used by PCU's to obtain an IP address via bootp.
http Web Access, for read-only database access.
rlogin.

FTP into Linux partition.

Might be required for Web access through
cgi-bin.

Used by dbvisit (maintenance program) for
on-line dbvisits.

Server listens for client connections.

Server updates/notifications to client, specified
by client. Each client running on a machine must
bind to a unique socket. If a user intends to run N
sessions of INEWS on the same machine, then
ports 1020 through 1020 + (N-1) must be opened
in the firewall (TCP and UDP).

iNEWS bioserver communication. More often
used on 2-server systems, but might use
loopback.

Used by connect command during startup.



Avid Interplay Port Usage

Component and Location

Instinct

Interplay Engine

Interplay Framework / Media
Indexer

LDAP

Media Services Engine

Port

5901

6100
6101
6825
6826
49152

8321
80

dynamic (0 -
1024)

dynamic

dynamic -
above 1024

dynamic
4160
4160
389

636
8080
1099

Protocol

TELNET

uUDP

TCP

TCP

TCP

TCP

TCP/ UDP
TCP
UDP

TCP

TCP

TCP

Purpose

First remote access port for VNC to Linux UI,
might have more than one VNC session
configured (5902, 5903, and so on).

FTS indexing (configurable).
FTS searching (configurable).
Monitor, for ControlAir.
Monitor for MOS.

Telnet.

Instinct uses Access ports for Interplay engine
communication. It is also a Media Indexer client.
Instinct E3is also an iNEWS client. See
appropriate sections for port usage.

Server Browser.
Client communication.

Ports are dynamic and services register
themselves with firewall to use any port.

Codebase http server.

Jini™ ERI ServerConnectionManager.

Jini ERI ConnectionManager.

TCP/UDP notifications.
Jini Discovery.

Jini Discovery.

If SSL is enabled.
Listen for editor clients (SOAP).

Listen; RMI protocol for providers and
Status/Admin tool.
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Avid Interplay Port Usage

Component and Location Port Protocol Purpose
42000-4206 TCP If 1099 not available.
0
Media Services Providers / Status 1099 TCP Outbound; RMI protocol for providers and
Tool Status/Admin tool.
42000-4206 TCP If 1099 not available.
0
NewsCutter 21 Required for NRCS tool.
8080 TCP Outbound; Media Services connection to Media
Services Engine (SOAP).
NewsCutter uses Access ports for Engine
communication. It also runs the Interplay
Framework and a local Media E3Indexer; see
appropriate sections for port usage.
ProEncode Client 8080 TCP/IP SOAP Connection to Media Services (TCP,
outbound) - run on editing systems
(NewsCutter).
Transfer Cache 1099 TCP Listen; RMI protocol for providers and
Status/Admin tool.
42000-4206 TCP If 1099 not available.
0
6539 TCP Outbound for Transfer Engine status.
Transfer Engine 6532 TCP/IP Media Connectivity tool (defined in
system32\drivers\etc\services com.avid.mct).
The TM server listens on this port for requests
from other TM servers (for example, initiating a
workgroup transfer.).
6535 TCP/IP Playback protocol (defined in
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system32\drivers\etc\services com.avid.pbp).
This is the default port used by TM Server for
connecting to Playback Servers (Airspace etc.).
This is configurable for some playback servers.



Avid Interplay Port Usage

Component and Location

Port

6539

Protocol

TCP/IP

Purpose

Transfer Engine (defined in
system32\drivers\etc\services com.avid.pbp
com.avid.xmgr). The TM Server listens on this

port for incoming requests from the TM Client.
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